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Introduction 

The GTXRaster CAD 2021 Series  

This manual describes the installation and use of Version 2021 of the 
GTXRaster CAD Series. The Series consists of two software products - 
GTXRaster CAD and GTXRaster CAD PLUS. Each provides different 
levels of raster cleanup, editing and conversion capabilities. 

GTXRaster CAD lets you thoroughly clean up and edit binary (black and 
white) raster within BricsCAD. GTXRaster CAD PLUS gives you the 
power to convert binary raster into BricsCAD vector entities.   

Product Level Raster 

Cleanup

Raster 

Editing

Conversion Character 

Recognition

Batch 

Conversion
GTXRaster CAD X X

GTXRaster CAD 

PLUS

X X X X X

Product Functionality

 

GTXRaster CAD 

GTXRaster CAD provides capability to efficiently clean and enhance 
raster images. It includes the following features: 

 Raster Snapping that emulates BricsCAD object snapping to raster 

data. 

 Integration with third party document managers and raster 

applications, using industry standard raster formats 

 Intelligent Object Picking (IOP) makes selection of raster objects 

as easy as handling CAD entities. 

 Improve drawing quality by using image enhancement to clean, 

deskew, scale, rotate and remove speckles. 

 Output changes to a variety of printers and plotters as a hybrid 

(raster and vector) or full raster drawing. 

 Intelligent Enhancement helps improve drawing quality and 

legibility while reducing raster file storage requirements 20-30% over 

already compressed formats. 
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In addition, GTXRaster CAD provides Raster Editing functionality for 
editing raster data in the same manner as vector data.  This extended 
functionality includes: 

Raster Edit commands treat scanned shapes as vector geometry. 

More Raster Snap modes make it easier to edit raster geometry. 

Intelligent Object Picking for selection of complex raster data and to 
preserve raster intersections instead of creating gaps. 

Manual Vectorization helps you trace raster with BricsCAD vector 
entities. 

GTXRaster CAD PLUS 

GTXRaster CAD PLUS includes all the functionality of GTXRaster Tools 
and GTXRaster CAD. It also provides powerful geometry and text 
conversion tools for transforming raster images into intelligent BricsCAD 
drawings. 

Raster-to-Vector Conversion converts selected raster data into 
BricsCAD entities. 

The Intelligent Character Recognition (ICR) quickly converts raster 
text, typically 20% of engineering drawings. ICR is different than OCR 
(optical character recognition) because of its unique training capability 
that allows you to train the software to recognize new fonts or custom 
lettering styles. Dictionary look-up and pattern matching make ICR 
perfect for recognizing the complicated text, such as part numbers. 
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Mastering the GTXRaster CAD Series 

User’s Manual 

You can use this manual to learn about the software in several ways: 

 Using the GTXRaster CAD Series provides an overview of working 

with raster in BricsCAD Pro & Platinum V20 and general principles 

about using GTX software (Page 18). 

 Getting Started demonstrates features and functions of the software 

in step-by-step lessons (Page 30). 

 The Command Reference describes each GTXRaster CAD 

command and feature in an alphabetical list (Page 32). 

 Use the Index to look up any term for which you need more 

information. 

Other Sources of Help 

 Use the Windows Help file: You can launch this from the GTX 

program group help icon, by typing gHelp from the command 

prompt, by selecting HELP from the GTX RCAD pull-down menu, or 

by pressing F1 at a GTX command-line prompt. These execute our 

online help file, rcadwin.chm, from the GTX program folder. 

 The GTX Web site at http://www.gtx.com contains product 

information, frequently asked questions (FAQ) and technical notes. 

 Step-by-step Tutorials and Instructional videos are available at 

http://www.gtx.com/support/tutorials.asp 

Technical Support 

 Always contact your authorized reseller first for technical support 

issues. 

 A maintenance agreement is available for purchase from GTX 

Corporation.  Contact your GTX reseller for details. 

 E-mail questions to GTX at: support@gtx.com. 

Installing the Software 

The Installation section describes how to install and configure all levels 
of the GTXRaster CAD Series.  

The Appendix 

 Glossary of Terms - Defines special terms used in this manual  

printed in boldface.  

http://www.gtx.com/
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 Configuration File - Describes the configuration file and its 

parameters. 

 Raster Formats - Lists supported raster import and export formats. 

BricsCAD Compatibility 

The GTXRaster CAD Series runs inside BricsCAD Pro & Platinum, so all 
keyboard controls work the same as BricsCAD: 

 The [RETURN] and [Space] key can be used interchangeably to 

end a command sequence or close a selection. 

 By the default BricsCAD configuration, [Esc] cancels commands. 

 GTX commands allow transparent commands to run while another 

command is running (i.e., a Transparent Zoom is done by typing an 

apostrophe before the command name: ZOOM or Z). 

Software Configuration 

The GTXRaster CAD Series receives many of its default values from 
GTXRAST.CFG. This file can be edited with any ASCII text editor (such 
as Notepad or WordPad). 

 

 

 

 

 

 

 

 

 

 



 

 10 

 

Raster Files 

The raster files you will use with the GTXRaster CAD Series are created 
by a scanner. Properly calibrating your scanner and following its 
instructions will generate better images. The better the image, the less 
cleanup is necessary. 

File Format 

For a list of accepted raster file formats, see Appendix A3, Raster 
Formats, on page 197. 

Image Size 

Some raster file formats allow a maximum size of 32,768 (32K) pixels in 
both the X and Y directions. If your drawing limits are large, be sure your 
pixels are also large. For example, at 400 DPI, 32K pixels equals 
approximately 80 inches. The maximum raster limits are also restricted 
by the available memory and your system’s swap file size. 

Resolution 

If your scanner outputs high-resolution files, you can set a lower 
resolution in the GTXRAST.CFG file to minimize memory requirements. 
Raster files can require more memory than CAD files and higher 
resolutions require more memory. 
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Installation 

System Requirements 

Minimum requirements are the same as BricsCAD, but more RAM and 
virtual memory are definitely recommended. 

CPU  64-bit:  

AMD Athlon 64 with SSE2 technology 

AMD Opteron™ with SSE2 technology 

Intel® Xeon® with Intel EM64T support 
with SSE2 technology 

Intel Pentium 4 with Intel EM64T support 
with SSE2 technology 

Operating System Windows 8/8.1 Pro, Windows® 7 Enterprise, 

Ultimate, Professional, or Home Premium  

Editions 

Drive space 150 MB free hard disk space 

Memory 2 GB (8 GB recommended) 

Display 1024 X 768 or better 

BricsCAD version Full BricsCAD Pro & Platinum V21 

Installing the Software 

Please make sure you have selected an appropriate BricsCAD profile 
before installing GTX software. This means that you will need to have 
run BricsCAD at least once before installing GTXRaster CAD.  To install 
your software: 

Installation Steps 
1. Run SETUP from GTX DVD or download the installer from 

http://www.gtx.com/register/download.asp 

2. Read README.PDF and other files for recent changes to the 

installation!  
 

Note: For installations performed under Administrative login, but not 
visible under a user's login, rerun the 
RCAD2021\RCAD202164EN_BricsCAD.exe from the DVD ROM, 
while logged in as the user, and select Update Registry'. 
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Running SETUP 

1. Insert the installation DVD, if applicable. 

2. If your AutoRUN is active on your system, a dialog will appear. 

Select GTXRaster CAD 2021Series, and then under BricsCAD 

V20, select Install.  

3. If AutoRUN is not active, the dialog will not appear when you 

inserted the DVD. Run 

D:\RCAD2021\RCAD202164EN_BricsCAD.EXE (Assuming D: is 

your DVD-ROM drive) to start the installation. 

4. Click OK. 

SETUP will initialize and after a few seconds the software license 

agreement will appear. 

5. Select Licensed and Next if you are installing the product of which 

you have purchased a license.  

6. SETUP prompts you for 

the Product Level (the 

actual name of the 

software you 

purchased).  Select the 

appropriate product 

level name and select 

Next.  This sets the 

ProductLevel= 

configuration parameter 

in gtxrast.cfg. 

 

NOTE If you select the wrong product level, then your software will not 
run correctly!  Be sure to enter the correct product name –
GTXRaster CAD or GTXRaster CAD PLUS. 
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9. The Choose Destination Location dialog appears. To install the 

program in a custom directory, select Browse to establish the new 

destination. Once the correct Destination Directory is displayed, 

Select Next. 

10 If you are installing as the administrator, SETUP will create a 

common program folder, which will be visible to any users logged in 

on the computer. 

11. SETUP installs the program files from the installation DVD. 

Readme 

README.PDF contains any changes to the installation and configuration 
process not yet documented by this manual. 

Program Groups/Folders 

SETUP creates a GTXRaster CAD 2021 program folder containing the 
icons used for running GTXRaster CAD and its accompanying programs.   

Software Licensing 

GTXRaster CAD 2021 Series is available in a single user standalone 
version and a networked floating license multiple user version.  

Please visit http://www.gtx.com/supportsoftwarelicensing.asp  for detailed, 

step-by-step instruction on how to license the software. 

Installation of a standalone software licensed GTXRaster CAD 2021 
Series is dedicated to a particular personal computer, whereas a 
hardware lock licensed installation is portable from computer to 
computer. The networked floating software license is distributed from a 
License Server System, which is dedicated to a particular computer. 
Access to a floating GTX software license is available to any personal 
computer which shares a common network with the License Server 
System. 

For details on installing the FLEXNet software locking refer to the 
GTX_Flex_Licensing.chm help file or 
http://www.gtx.com/support/faqs.asp 

 

 

 

http://www.gtx.com/supportsoftwarelicensing.asp
http://www.gtx.com/support/faqs.asp
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Critical Configuration File Parameters 

Two configuration parameters are located in the configuration file, 
GTXRAST.CFG: 

PRODUCT LEVEL 

ProductLevel specifies the software level you intend to run. The 
installation sets this variable. If this variable is not listed, the program will 
default to RCADPLUS. 

For GTXRaster CAD  set ProductLevel = RCAD 

For GTXRaster CAD PLUS set ProductLevel = RCADPLUS 

 

Note: If the product level listed is different from the product you 
purchased, your program will only run in demo mode.  If you keep 
running in demo mode although you bought the product, make 
sure your product level is set to the correct level in the 
configuration file! 
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Uninstalling the Software 

To remove the GTXRaster CAD Series software from your system, use 
Add and Remove Programs from the Control Panel. 

Alternatively, you may run the setup program from the DVD ROM and 
select Uninstall. 

Removing the GTX Application Files 
Note: Uninstall will not remove files that were not placed on your system 

by SETUP, including modified configuration files, BricsCAD 
drawings or raster images. You need to remove those files 
yourself. 

Now that BricsCAD is no longer looking for the GTXRaster CAD Series 
files, you can remove these files from your system. 
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Borrowing a License 
GTXRaster CAD Series allows you to temporarily check out or borrow a 
license from a pool of available licenses residing on a network server; 
this feature is not available for single-user installations.  

In order borrow a license you must first request a network license 
file that allows for borrowing by contacting GTX at 
support@gtx.com. After the old network license file has been replaced 
with the borrowing-enabled license an end-user can borrow a license. 
GTXRaster CAD Series software must be installed on the computer 
where the borrowed license will reside, and the computer must be 
connected to the network where the licenses are hosted. 

License borrowing is tied to a particular computer; once the license is 
borrowed it will become unavailable for other users on the network.  

To borrow a license the end-user will run gLICENSE command on the 
computer where the borrowed license will reside, select “Borrow License” 
and then select a date within an allowed range, please take a note of the 
expiration date. 

 

For additional information on license borrowing and network license 
management please refer to GTX_Flex_Licensing.chm help file. 

 

 

 

mailto:support@gtx.com
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Returning a Borrowed License 
In order to return a borrower license the user’s computer must be 
connected to the original network where the license was 
borrowed/hosted. 

The end-user will run gLICENSE command and select “Return Borrowed 
License”, if the license is returned correctly a confirmation message will 
appear. 

 

Please note that the license will be returned to the server automatically once 
the borrowing period has expired.  
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Using the GTXRaster CAD Series 

The Purpose of This Section 

This section describes the use of the GTXRaster CAD Series software.  
The GTXRaster CAD series is a program that operates within BricsCAD 
V20 and many of its commands operate in a similar manner to BricsCAD 
commands. For example, in BricsCAD, the command for moving a CAD 
entity is MOVE. In the GTXRaster CAD Series, the command for moving 
raster data is gMOVE.  Both commands use similar prompts to 
accomplish similar tasks. 

Because GTXRaster CAD functions parallel BricsCAD’s, you will learn it 
more easily if you are familiar with the main BricsCAD functions, 
especially loading and saving drawings, attaching images, drawing and 
editing. 

Raster and Vector 

The GTXRaster CAD Series lets you draw and edit, load and save raster 
information. Raster images are made up of dots (pixels) that represent 
pictures by forming an electronic mosaic. If you zoom close to a raster 
image, you will see each pixel as a square. 

BricsCAD lets you draw and edit, load and save vector information. CAD 
drawings are made up of vector entities in which coordinates and other 
measurements are expressed mathematically in the CAD drawing. For 
example, a line is defined mathematically as the X and Y coordinates of 
each of its endpoints. A circle is defined as the X and Y coordinates of its 
center point and the length of its radius. Load a sample drawing into 
BricsCAD, window some of the entities and type LIST. You will see a 
barrage of entity types and coordinates. 

Note: It is easy to attach the same image twice in the same drawing. 
Each image object refers to the same raster file, so if the image is 
somehow changed on the disk, the images will immediately 
change in the drawing! 



 

 19 

BricsCAD V20 and Raster Images 

BricsCAD lets you Attach raster images within vector drawings, 
displaying the raster within image entities. Image entities do not store 
the image data; they only refer, or link, to raster files already residing on 
disk. Attached raster files must be present for them to appear within 
BricsCAD. You can set properties for an image entity in a drawing, but 
these properties are only stored in the BricsCAD drawing, only affect the 
appearance of the image and do not directly affect the raster file at all. 

BricsCAD will let you copy, move, rotate, scale and clip a raster image 
object within an BricsCAD drawing. The Image Adjust feature adjusts the 
display of an image’s brightness, contrast, fade and transparency.  

An BricsCAD drawing provides an excellent framework for managing and 
modifying one or more related raster images. BricsCAD lets you display 
images to scale with the BricsCAD vector drawing coordinates. 

What Does GTX Add to BricsCAD? 

The GTXRaster CAD Series adds raster enhancement, editing and 
conversion abilities to BricsCAD’s display and plotting capabilities. 
GTXRaster CAD can modify attached raster images and save them. 
GTX lets BricsCAD attach new raster formats. GTXRaster CAD extends 
BricsCAD’s AutoSnap feature to work on raster data, making it easier to 
trace over raster information with BricsCAD entities. The GTXRaster 
CAD Series lets you easily convert whole selections of raster into 
intelligent CAD entities within the BricsCAD drawing. GTXRaster R2V 
and GTXRaster CAD PLUS provide conversion clean-up tools to help 
make converted data more precise. 

Product Functionality 

Loading Raster Images Into BricsCAD 

BricsCAD and GTXRaster CAD provide you with several ways of 
importing raster images. To load a raster image into BricsCAD, the 
software attaches it within BricsCAD drawing. The image is not stored in 
the .DWG file, but is viewed through it. When attaching an image, be 
sure of whether you are putting it in paper space or model space. 
Although the raster is only an image of a paper drawing, you can attach 
an image in model space and then scale the image entity so it is to 
scale with the BricsCAD coordinate system. 
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Learn to use BricsCAD’s IMAGEATTACH command before using any 
other methods. BricsCAD also supports dragging and dropping raster 
files of TIFF or .CAL raster formats. 

GTXRaster CAD provides the gATTACH command to quickly attach 
images without prompting for insertion point, scale and orientation. 
Instead, it makes certain assumptions about how to place, scale and 
orient raster images. 

 

Attach Method 
(Source) 

  

IMAGEATTACH 

(BricsCAD) 

 Command supported by 

BricsCAD 

 Offers full control of 

insertion point, scale & 

orientation 

 Numerous steps to import 

an image 

Drag-and-Drop 

(BricsCAD) 

 Easy to specify file - just 

drag it 

 Still have to specify 

insertion, scale & angle 

 Only works with TIFF, & 

CALS formats 

gATTACH 

(GTX) 

 One-step image import 

 Migrates earlier GTX 

hybrid images to 2021 

 

 Always inserts images at 

same location, scale and 

orientation. 
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Scaling and Aligning Attached Raster Images 

Once an image has been imported into BricsCAD, it should be scaled 
and aligned to fit the drawing. Learn how to use BricsCAD’s SCALE 
command to properly scale the drawing. If you are working with line 
diagrams without a scale factor, you will probably want to bring attach 
images at a scale of 1, duplicating the original paper drawing. Use the 
scale factor of scanned drawings to determine how to scale its image 
entity to match the BricsCAD model space coordinates. 

Example: 

Having attached SIDE.CG4 from the GTX tutorial 
files at 0,0 at 0 orientation at scale of 1, the 
drawing would look like this: 

 

The dimensions in the raster image indicate the required size of the 
raster if it were a drawing represented within BricsCAD’s model space. 

The raster image will scale itself so that the geometry it portrays is to 
scale with BricsCAD’s model space. 

Note: Raster line widths will also scale along with raster images. 

Orienting and Rotating Image Entities 

Often paper drawings are scanned sideways. If you used BricsCAD’s 
Image>Attach command to import a raster image, it may end up 
sideways. There are two ways to solve this problem: 

Command Explanation 
Command: SCALE Invoke the SCALE command 

Select objects: 1 found Select the SIDE.CG4 image entity 

Base point: 0,0 Scale from the base point 0,0 

<Scale factor>/Reference: R Use a reference length to scale the 

image entity 

Reference length <1>: Pick the first point along the 2 

dimension 

Second point: Pick the second point along the 2 

dimension 

New length: 2 Type what the dimension reports its 

length to be 
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GROTATE COMMAND 

   

The gROTATE command rotates raster data within the raster image.  It 
is useful for raster editing, but is not recommended as a tool for 
registering images within BricsCAD drawings. 

BricsCAD’s ROTATE command can rotate the image entity, effectively 
correcting its appearance in the drawing. Some problems with this are: 

 The insertion point is no longer the lower left point because it gets 

rotated along with the image entity. 

 The image entity rotates about some base point, which can require 

additional adjustments to correctly line up the image. 

GTURN COMMAND 

    

 The gTURN command can also be used to rotate an image, but it 
preserves the insertion point as the lower left point. Advantages of using 
this command are: 

 The image entity is turned maintaining the lower left point as the 

insertion point. 

 The image entity hasn’t moved about any base point. If the image 

was in the right position before invoking gTURN then it requires no 

further moving or adjusting. 

Either technique positions raster data; gTURN does so in fewer steps. 

Creating New Raster Images 

 The GTX command, gCREATE, allows you to create a new raster 
image. Just like scanned images that were captured from paper or mylar 
drawings, new images should be drawn at some drawing scale.  New 
raster images are limited to realistic sizes.  Create new raster images 
that are approximately paper-sized, and then scale the image entities 
using BricsCAD’s Scale command. 
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For example, when creating a new image, you cannot make a raster 
image equivalent to a piece of paper the size of a city block.  Instead, 
create a raster image the size of a large sheet of paper (E- or A0-size). 
Then scale the image entity with the Scale command.  This way you can 
avoid attempting to create oversized raster images. 

Cropping Raster Data 

Two commands are useful for erasing raster outside a rectangular area. 

gCROP erases raster data outside a rectangular box. The raster image 
stays the same size.  

 

 

gRESIZE removes the portion of the raster image outside a selected 
box. Raster data outside this box is erased because the raster image no 
longer occupies that space. 
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Modifying Images 

gACTIVE loads the image into the GTX editor, making it the current 
image for editing. If there is no active image, raster editing commands 
will invoke gACTIVE before proceeding. When there are multiple images 
attached, gACTIVE command will require you to select the image to 
prepare. If there is only one image attached in BricsCAD, gACTIVE will 
automatically prepare it. gINACTIVE releases the image, recovering 
memory. 
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Cutting and Pasting Raster 

The GTXRaster CAD Series displays raster through BricsCAD image 
entities, which can be attached at any scale or orientation. 

Scanning a paper drawing Raster file at 270° 

BricsCAD Image rotated at 

90° 

gCUT a section from a rotated 

image 

gCUT produces the cut data as a new image, 

which is at a 270° orientation,  just like the source 

raster file: 
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Images oriented at angles other than 0 and 90 behave consistently. In 
this example, an image was inserted at a 30° orientation, and gCUT is 
used to create a new image. The cut image is taken from the source 
image at 0° - not at 30°: 

Converting Between Raster and Vector 

The GTXRaster CAD series provides many commands that will convert 
data between CAD and raster formats.  These commands are found 
under the GTXConvert menu. 

For more information, see the references for the following commands: 

VECTOR-TO-RASTER COMMANDS 

gRASTER, gBURN 

 

 

 

gCUT from a rotated image 

gCUT produces the cut data as a new image, 

which is at a 0° orientation, not at 30° like the 

source image entity. The border is larger than 

that specified during the gCUT command 

because it was cut at an angle. 

BricsCAD image rotated at 30 ° 
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RASTER-TO-VECTOR COMMANDS 

gCONVRT, gECONVRT, gTRACE, gVECTOR 

 

INTELLIGENT CHARACTER RECOGNITION 

gTCONFIG, gTRAIN, gTCONVRT 

 

Vector Cleanup 

The commands under the GTXVClean menu aid in cleaning up drawings 
after conversion from raster. For more information on each command 
refer to the light blue backed icons in the ‘Command Reference’ section. 

 

Snapping to Raster 

GTXRaster CAD provides many transparent raster snap methods that 
help you select points precisely within raster images.  In addition, these 
raster snaps can be used when drawing raster or vector entities as well! 

 

 



 

 28 

RASTER AUTOSNAP 

Better yet, GTXRaster CAD, GTXRaster R2V and GTXRaster CAD  
PLUS raster-enable BricsCAD’s AutoSnap™ feature in which a ToolTip 
appears to indicate the type of raster snap being employed.   

The GTX command, gAUTOSNAP, controls whether AutoSnap™ will 
work within an image.  Refer to the gAUTOSNAP command reference for 
more information. 

 

Saving Images 

The GTXRaster CAD Series provides several ways of saving modified 
images. In addition to saving .DWG files, BricsCAD’s SAVE command 
will also save any changed images.  

The gSAVE command lets you change the filename (and image format) 
of an image. 

Command Description 
SAVE Saves .DWG and any modified images. 

GSAVE 

 

Saves the current image.  

QUIT When quitting BricsCAD, unsaved images can be saved. After 

saving, BricsCAD .DWG is saved. 

GTXRaster CAD Series Performance Factors 

Because raster files can be so large, certain operating parameters affect 
system performance. In Minimum Requirements, we described the 
minimum recommended hardware configuration. The following BricsCAD 
and GTXRaster CAD Series parameters can also optimize display and 
editing speed: 
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Automatic Save Interval 

GTXRaster CAD Series saves modified raster images every time 
BricsCAD performs an Automatic Save. You can increase the time 
interval between automatic saves and minimize this kind interruption by 
increasing the BricsCAD SAVETIME system variable. 

Swap Space 

Larger paging files can help performance when working with large raster 
images. 

Aerial View 

The aerial view maintains a second copy of the image in memory. To 
save memory you can keep this view closed. Additional processing time 
is taken when the Aerial View is set to automatically update. Turn off the 
automatic update option after loading the drawing. 

Current View/Zoom 

Redrawing images takes extra time. Performing a command generally 
takes longer if you are zoomed to extents than if you are zoomed in on a 
small area of the drawing. 

Image Quality 

Set the Image Quality to Draft to save additional time. High quality slows 
processes. Raster plotting occurs at high quality even when images are 
displayed in draft mode. 

Multiple Images 

BricsCAD easily handles multiple overlaid or tiled images. Attaching 
additional images can slow editing response. 
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Getting Started 

Please visit the following link to access the 
Tutorials:  

http://www.gtx.com/support/tutorials.asp 

Using the Tutorials 

To get the most from these lessons you should be familiar with BricsCAD 
V20’s image commands. Experiment with the BricsCAD Image 
command to attach images within BricsCAD, ImageAdjust, 
ImageQuality, Transparency, basic drawing and property-modifying 
commands (entity drawing commands, the Properties command, Object 
Snapping modes). 

Following the Lessons 

Try performing these exercises twice. The first time, follow the 
instructions literally to learn how each command and feature works. The 
second time, try to accomplish the same results as fast as possible, 
using the options and techniques with which you are most comfortable.  

You won’t need to change your approach to working with BricsCAD to 
use the GTXRaster CAD Series. The toolbar icon and keyboard shortcut 
for each command and feature have been provided in the left margin. 

Standardizing Your Environment for the Tutorials 

The lessons invoke GTXRaster CAD Series features from menus. 

The BricsCAD variables CMDDIA and FILEDIA control whether dialog 
boxes are used in certain commands. If CMDDIA and FILEDIA are set to 
1, many GTXRaster CAD Series commands use dialog boxes. If these 
variables are set to 0, many GTX commands will use BricsCAD 
command-line prompts. The lessons will describe the commands as they 
run with these variables set to “1”. 

http://www.gtx.com/support/tutorials.asp
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Editing a Raster File 

A typical editing session begins with enhancements that operate on most 
or all of the drawing. Next, make more detailed changes. Finally, focus 
on the overall picture to make sure the sections are properly matched 
and aligned. 

1. The GTXRaster CAD Series cannot modify images until you prepare 

them for editing. (gACTIVE) 

2. Get rid of meaningless or unwanted raster to reduce memory 

requirements and to clean the image. (gCROP, gSPECKL, 

gERASE) 

3. Because documents are usually scanned at a slight angle, deskew 

raster drawings before proceeding. (gDESKEW) 

4. Next, perform editing functions that involve the whole drawing or 

large areas of the drawing. (gMIRROR, gCUT, gPASTE) 

5. Completely edit the image in one area before moving on to another 

area. Insert missing objects and correct distortions with both 

BricsCAD and GTX commands. Leave new entities in vector format 

or rasterize them using gRASTER. Use Raster Snapping methods 

to select points on raster geometry just as you do using object 

snaps. 

6. Create and edit text. If using GTXRaster CAD PLUS, use 

gTCONVERT to convert raster text into BricsCAD text entities. 

7. Look at the whole drawing and make any required changes (gCOPY, 

gMOVE, gROTATE and gSMOOTH). 

8. Place new border and title block if needed. 

7. Save the file. (SAVE, gSAVE, gCUT). 

Please visit the following link to access the Tutorials:  

http://www.gtx.com/support/tutorials.asp 

http://www.gtx.com/support/tutorials.asp
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Command Reference 

This section defines the GTXRaster CAD series commands and 
features. The first few pages include new and changed commands, a set 
of overview tables listing each command and feature with icon and brief 
description. Read detailed command descriptions through the rest of the 
section, indexing along the top margin of the page to find each command 
name. 

Command Overview 

Icon Command Shortcut Description 

 gACLEAN GACL Automatically deskews and deletes noise in 

the active image.   

 gACTIVE GAC Prepares a selected image as the active 

image, ready for raster editing or 

conversion 

 gADESKEW GAD Automatically rotates the current raster 

image to align raster to an orthogonal 

orientation.  

 gARC  Draws a raster arc in the current raster 

image 

 gAUTOSNAP GAS Enables BricsCAD’s AutoSnap™ options 

within active image entities 

 gARRAY GAR Creates a circular or rectangular array from 

selected raster data 

 gATTACH GA Quickly loads raster images 
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 gBURN GBU Converts all vectors to raster, “burning” 

them into the current raster image 

 gCALIKE GCA Changes circles and arcs to have the same 

radius as a selected circle or arc 

     gCARC                                         Changes the size or position of an arc 

 

 gCCIRCLE                                   Changes the size or position of a circle 

 

  gCCIRCLE2P                               Changes the size or position of a circle 

 

 gCELEV GCE Assigns incremental elevations to multiple 

polylines 

 gCHANGE GCH Changes the size or position of a line, arc 

or circle 

 gCHGLAY GCHL Changes the layer of objects to that of a 

specified object 

 gCIRCLE GC Draws a raster circle in the current raster 

image 

 gCLEANIOP  Automatically deskews the active image 

and places speckles and other noise in a 

selection set  

       gCLINE                                        Changes the size or position of a line 

 gCONCEN GCONC Moves circles and arcs to be concentric 

about a location or about the centerpoint of 
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a specified circle or arc 

 gCONVRT GCO Converts selected raster data to vector 

 

 gCOPY GCP Copies selected raster data to a new 

location on the image, retaining the original 

 gCAI  Copies all images using the BricsCAD 

COPY command 

 gCREATE GCR Creates a new raster database or flush the 

current raster database 

 gCROP GCRO Deletes all information outside of a 

specified window 

 gCTEXT  Change raster text by text replacement 

 gCUT GCU Copies selected raster data to a file or 

buffer 

 gDESKEW GD Aligns raster data in current raster image to 

0 and 90 degrees 

 gDETACH  Single step detachment of an image 

 gDRO_BK  Sets all image entities’ draw order behind 

other entities 

 

 gECONVRT GEC Creates a vector edge around selected 

raster 

 gEDGE GED Creates a raster edge around selected 
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raster 

 gERASE GE Removes selected raster data 

 

 gFRZLAY GFR Freezes the layer of a specified object 

 gHELP GH Launches the online help 

 gHTEXT  Edit vector text and create a raster text 

underlay 

 gHYBRIDMODE  Enable vector overlay of drawn raster lines, 

arcs, circles, rectangles, and text 

 gINFO GI Displays information about the raster 

database 

ImageFrame  Configures the BricsCAD Image Frame 

  

 ImageTransparency Controls BricsCAD image transparency 

 

 gINACTIVE GINA Deactivates the currently active image, 

freeing memory 

 gINVERT GIN Reverses the raster foreground and 

background data Useful for raster scanned 

from negative images 

 

 gISOLAY GISL Freezes all layers except that of a selected 

object 

 gJOIN GJO Joins lines 
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 gLINE GLN Draws lines on current raster image 

 gLINE2                                         Draws multiple separated lines 

 gMCOPY  Copies selected raster data to multiple 

second points 

 gMIRROR GMI Mirrors selected raster data 

 gMOVE GM Moves selected raster data 

 gMAI  Moves all images using the BricsCAD 

MOVE command 

 gOFFSET GOFF Creates concentric raster circles, parallel 

raster lines and parallel raster arcs 

 gPASTE GP Pastes raster data from a raster file or a 

buffer created with gCUT 

 gPDFATTACH GPDFA Loads or attaches a PDF image 

 gPDFSAVE GPDFSA Saves the currently selected raster image 

to a PDF 

 gRAHEAD GRAH Erases “arrowheads” (solids with three 

points) 

 gRASTER GRA Converts selected vector entities to raster 

    gRECTANGLE                             Draws a raster rectangle  

 gREFLCT GREF Mirrors the entire image in either the X or Y 

axis, replacing the original image 

 gRELIMIT GREL Combines trim and extend for lines 
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 gRESIZE GRE Resizes the image entity (Adds or removes 

pixels without scaling the image entity) 

 gROTATE GR Rotates selected raster data 

 gROTRECTANGLE Draws a raster rectangle at any orientation 

angle 

 gRAI  Rotates all images using the BricsCAD 

ROTATE command 

 gRUB GRU Erases raster data under selected vector 

data 

 gSAI  Scales all images using the BricsCAD 

SCALE command 

 gSAVE GSA Saves the raster image 

 gSCALE GS Scales selected raster data 

 gSETLAY GSL Sets the current layer to that of a specified 

entity 

 gSLICE                                         Creates a 2 pixel wide gap between raster 

objects 

  

 gSMOOTH GSM Smoothes selected raster. This feature is 

now available under GTXRaster CAD and 

higher levels of the software 

 gSPECKL GSP Perform raster object speckle removal to 

selectively erase background noise or fill in 

holes in the raster image 
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 gTCONFIG GTCFG Configures Text Window IOP, Text Line 

IOP and the gTCONVRT/gTRAIN 

commands 

 gTCONVRT GTC Converts raster text to BricsCAD text 

entities 

 gTEXT  Draws raster text or draws hybrid text if 

gHybridmode is enabled 

 gTRACE GT Traces vector lines, arcs, and circles over 

selected raster geometry (raster remains) 

 gTRAIN GTR Previews and edits text recognition files 

used by gTCONVRT. 

 gTRANS_ON  Makes all images transparent 

 gTURN GTU Reorients the work area (and image) by 90, 

180 or 270 (-90) degrees 

 gVECTOR GV Traces raster to vector lines, arcs and 

circles. 

 gVSKEW GVS Deskews vector data 

 gWARP GW Corrects distortions in an image 
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Raster Picking Options 

Most commands affect a subset of the raster image. To gMOVE a raster 
circle, you need to first pick that circle. The GTXRaster CAD series uses 
Intelligent Object Picking (IOP) to pick raster entities from the drawing 
as if they were intelligent CAD entities. These options can be typed, 
found in the GTX Edit>Raster Pick, the toolbar or the screen menu. 

The following list describes each IOP option 

ICON 
PICK 
OPTION 

SHORT 
CUT 

DESCRIPTION 

                      

 ADD  AD Add data to the selection set (after using “remove”) 

  

 REMOVE  R Remove selected data from the selection set 

 ALL  ALL Select all raster on the current raster image 

 

 ALLTEXT  Selects (or deselects) all text in the current raster image 

 WINDOW  W Select all raster within a rectangular window  
   

 RWINDOW  Select all raster within a rotatable rectangular  window 

 PWINDOW PW Select all raster within a polygon window 

 CROSSING CR Select connected raster objects that are completely 
   contained by, or crossing, the edge of a window 
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 PCROSSING PC (Polygon Crossing) Select raster that is completely 
   contained by, or crossing, the edge of a polygon 

 

  RCROSSING  Select raster that is completely contained by or crossing   
   the edge of a rotatable rectangular window          

  INSIDE I Select raster objects completely contained by a window  

    RINSIDE        Select raster objects completely contained by a  
                                              rotatable rectangular window 
 
 

 OUTSIDE OW Select all raster outside a rectangular window  
     

  PINSIDE PI Select connected raster objects that are completely  
   contained by a polygon    
  

    FENCE F Select connected raster objects that are intersected by 
   a line      
             

   OBJECT O Select contiguous raster data within the current view 
  
            
          
 ARC AR Select raster arcs under a reference arc  
     

 2 PICK CIRCLE   2PC        Select raster circle using a 2-point reference circle  

   
 CIRCLE CI Select raster arcs or a circle under a reference circle 
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 LINE L Select raster lines under a reference line  
   

 PREVIOUS PR Pick the raster objects in the previous selection set 
   

 SEGMENT S Selects a linear raster segment in both directions from 
   a pick until it stops or finds an acute angle or a branch 
          
 TEXTLINE TEXTL Select text-sized raster elements that are intersected by 
   a reference line. Separates text from touching raster 
          
        
 TEXTWINDOW   TEXTW Select raster text elements that are within a rectangular 
   window. Separates text from touching raster elements 

 UNDER D Pick raster under selected vector objects  
          
  

 UNDO U Remove data from the selection set added by the last 
                       pick made     
  

 VIEW V Select all raster data within the present view 
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Working with GTX’s Intelligent Object Picking (IOP’s) 
Although GTX’s IOP’s are not commands in their own right, they are operators that allow you 
to precisely select the raster data that you wish to work with. IOP’s are fundamental to the 
effective use of GTX and users should spend time to understand how the various IOP’s work. 

 
To better understand the IOP operation we have highlighted some of the ways in which 
you can use the IOP’s for practical raster selection. The GTX IOP’s work with most of the 
raster commands, but for this example we have used the raster erase command – 
gERASE. 
 
Start by loading the GTX sample file called GTXVBELT.CG4 then initiate the gERASE 
command & try the following IOP selections. Note that in these examples RED is the 
normal (passive) Raster & GREEN is the selected areas. 
 

Window IOP’s 
Firstly there are six Window selection IOP’s – Window (Implied Cutting Window), 
Crossing Window & Inside Window. Using rectangular pick or a rotated baseline and 
height pick on the raster: 

 
________________________________ 

  

Using the IOP Window  (Cutting) option the raster selection would pick:   

 
It only selects the cut rectangular window area. 
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Using the IOP Crossing (Window) the raster selection would highlight: 
 

 
The Crossing IOP extends to include all crossing raster elements. 

This is ideal for quickly picking up large areas of the drawing especially views & 
sections. Isolating text is often an advantage & note how the text is not selected. 

________________________________ 
 

Using the IOP Inside (Window) the raster selection would select: 
 

 

Inside is great for only picking elements totally within the selected Window.  
It’s Ideal for selecting text, broken lines & parts list items.  

________________________________ 
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 IOP RWINDOW to select all raster contained within a rotatable rectangular 
window selected by two baseline points and a height point. 
 

                                                                        
 
 
 
 
 
 
 

Select two points of baseline       Select Rwindow height 
 

 IOP RCROSSING will select raster that is completely contained by or crossing 
the edge of a rotatable rectangular window selected by two baseline points and a height 
point. 

 
 
 
 
 
 
 
 

Select two points of baseline        Select Rcrossing 
height 
 

 IOP RINSIDE Select raster objects completely contained by a rotatable 
rectangular window selected by two baseline points and a height point 
 

                  
Select two points of baseline          Select Rinside height 
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Polygon Window IOP’s                      
 
Next there are three Polygon Area selection IOP’s – Pwindow (Implied Cutting area), 
Pcrossing & Pinside. They are similar in operation to the Rectangular Window 
selections only you select a freehand polygon. Clicking Right Mouse button closes the 
polygon.  Example of Pwindow: 

               

 
________________________________ 

 
Element Selection IOP’s – Line, Circle & Arc 
 

     Using IOP Line it is possible to pick or move a raster line which crosses other 
raster data. The key benefit is that it leaves any crossing intersections intact & you do not 
need to repair any intersecting raster. 
 

Just select two points over the raster line you wish to select: 

 

                            
________________________________ 

 
 
 
 
 
 
 
 
 

Similarly using IOP Circle it is possible to pick or move a raster circle which crosses 
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other raster data. Again it leaves the intersections intact & can greatly reduce editing 
time.  There are two IOP circle options: 
 

Three Point IOP circle selection -  or  Two Point IOP circle selection (with 
bounding circle).  Below is a two point IOP Circle example: 

                  
________________________________ 

 

  In the same way using IOP arc it is possible to isolate or move a raster arc which 
crosses other raster information. You need to select three points to identify the arc: 
 

           
 

________________________________ 
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IOP Text Selection 
 

There are three IOP selections that will isolate text. All commands use the text height 
settings in the GTX config file (GTXRAST.CFG) or if you have the GTXRaster CAD PLUS 
module you can change the sizes in the TEXT Recognition Config dialog (gTCONFIG). 
 

  IOP Textwin selects text within a given window.  

             
  

________________________________ 

  IOP Textline selects text intersecting a drawn two point line. 
 

     
________________________________ 

 

  IOP Alltext is a very powerful selection that identifies text over the whole drawing 
with just one pick! 

 
________________________________ 

 



 

 48 

Other useful IOP selections: 
 

 IOP Fence is very useful for selecting drawing data when converting & smoothing. 
With careful use of IOP Fence you can quickly pick complete views but not select text. 
Ideal for selecting parts lists & drawing borders. 
 

  
________________________________ 

  IOP Object allows you to pick a single connected piece of raster data with one pick. 
 

                 
________________________________ 

      IOP Segment is ideal for picking free running raster lines. The selection stops at 
logical intersections. This can be very useful when working on maps to isolate specific 
contour lines. 
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 Raster Object Snapping Options 

The GTXRaster CAD series provides transparent “raster snaps” similar 
to but independent from BricsCAD object snaps. While using an 
BricsCAD or GTX command, select Control-Right-mouse button to 
choose raster snaps from a pop-up menu. 

In addition to transparent raster snaps, the GTXRaster CAD series 
includes the gAUTOSNAP command, enabling BricsCAD’s Endpoint, 
Intersection, Nearest and Node AutoSnap™ methods within active 
raster entities. The following table lists each raster snap option. 

Icon Name Keyboard Description 
 None rnone Disables previous snap mode settings.  

 

 Endpoint ‘rend Snaps to the nearest end of a raster entity. 

Endpoint activates as running snap under 

BricsCAD’s End AutoSnap™. 

 

 Intersection ‘rint Snaps to the intersection of two or more 

raster entities. Intersection activates as 

running snap under BricsCAD’s Intersection 

AutoSnap™. 

 Nearest ‘rnea Snaps to the centerline of the nearest raster 

object. Nearest activates as running snap 

under BricsCAD’s Nearest AutoSnap™. 

 

 Edge ‘redge Snaps to the edge of the nearest raster 

object. Edge activates as running snap under 

BricsCAD’s Node AutoSnap™. 

 

 Center ‘rcen Snaps to the center of a circle or arc defined 

by three raster points 

 

 Midpoint ‘rmid Snaps to the midpoint of a line defined by two 

raster points 

 

 Midarc ‘rmida Snaps to the midpoint of an arc defined by 

three raster points 
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Command Definitions 

This section defines each command. The BricsCAD variables control the 
use of dialog boxes or prompts for many commands. FILEDIA controls 
dialogs for file commands and CMDDIA controls dialogs for other 
commands. Setting these variables to “1” enables the dialogs. Setting 
the variables to “0” disables dialogs and causes these commands to use 
BricsCAD command line prompts. 

 

 

gACLEAN 

Type Menu Availability 
GACLEAN 

GACL 

GTXEnhance>Auto clean GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gACLEAN automatically deskews the image and removes noise and 
speckles without forming a selection set; it is completely automatic.  
Another command, GCLEANIOP is interactive, forming a selection set 
that can be modified before erasing the noise. 

Instructions:  

Issue the Clean IOP command.  The program will automatically deskew 
the image and delete noise.  

NOTE If you are concerned about losing information from your 
drawing, you may use gCLEANIOP instead  
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gACTIVE (Active Image) 

Type Menu Availability 
GAC GTX Imaging>Active Image GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

Every raster editing/enhancing command requires an active image to be 
specified. The gACTIVE command is invoked automatically when there 
is none specified, so you won’t explicitly invoke this command unless you 
are working on more than one image at a time and wish to switch from 
one to another. 

gACTIVE sets active images to transparent. 

Options: 

Number of Images 

Note: Invoke gINACTIVE to make an active image inactive and save 
memory.  CLIPPING only masks the DISPLAY of images.  When 
editing a clipped image, the entire image is being edited 
(selections include clipped portions of an image, but after the edit, 
the clipping is still active). 

The behavior of gACTIVE varies depending on the number of images 
currently attached to the BricsCAD drawing: 

One Image: If there is only one image currently attached, gACTIVE 
will automatically set it as the active raster image. 

Two or More Images: If there are two or more images, a prompt will 
request that you select the one to edit. 

Image Type 

gACTIVE behaves differently depending on the number of images 
attached. 

Bi-Tonal: Bi-tonal images are activated quickly and easily. 

Color or Grayscale: Color or grayscale images are reduced to bi-
tonal (two colors) before becoming active. The color or grayscale image 
is not modified; rather, the command generates a bitonal version of the 
original. 
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gADESKEW 

Type Menu Availability 
GAD or GADESKEW GTX Enhance>Auto Deskew 

 

GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

Drawings are often scanned in slightly rotated. gADESKEW straightens 
a raster image by automatically rotating it to align with the X or Y axis.  

Instructions: 

1. Select gADESKEW. 

Deskew Entire Image? 

1. The deskew will take place, based on long raster lines found in the 

margin of the raster image. If no such lines are found, they will not 

deskew. 
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gARC 

Type Menu Availability 
GARC GTX Edit>Draw Arc GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

Draws a raster arc in the current raster image 

Instructions: 

gARC 

Enter or accept line width 

Start point: 

Select or type the first endpoint. 

Middle point: 

Select or type a second endpoint. 

End point: 

Select or type a third endpoint. The arc appears after the third point is 
specified. 

 Note: If there is no active image, gACTIVE will be invoked before 
continuing with gARC. If there is no image attached gCREATE will be 
invoked to set up an image into which raster line can be drawn. 
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gARRAY 

Type Menu Availability 
GAR or GARRAY GTX Edit>Array 

 

GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gARRAY copies raster data in rectangular or polar arrays. When creating 
a rectangular array, gARRAY arranges multiple copies of the selected 
raster in rows and columns. When creating a polar array, the command 
arranges copies of the selected raster placed about a circle. 

Instructions: 

1. Invoke gARRAY. 

Select raster <Window>: 

2. Select the raster data to be copied. Use any valid raster selection 

method. 

3. Press [RETURN]. 

Rectangular or Polar array (R/P) <R>: 

4. Enter R for rectangular or P for polar. 

Rectangular 

If using a rectangular array you must specify the number of rows and 

columns to be copied. 

Number of rows (---)<1>: 

a. Enter the number of rows you desire. 

Number of columns (|||)<1>: 

b. Enter the number of vertical columns you desire. 

Unit cell or distance between rows (---): 

c. You may enter a vertical distance numerically or draw a “unit 
cell” representing the distances between rows and columns graphically. 
If you enter a distance numerically then press [RETURN], you will 
receive the following prompt: 

Distance between columns (|||): 

d. Enter the distance that will separate the columns. The selected 
raster is copied. 
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Note: Positive x or y distances place copies to the right or above the 
original. Negative distances place them to the left or below the 
original. 

If you drew a unit cell instead of typing a distance, a rectangular box will 
rubber-band from the anchor point. Drag the box to represent the 
distance between both the rows and columns. The selected raster is 
copied. 

Polar 

If using a polar array you must specify the center point of the array, 

the number of copies, the angle to fill and whether or not to rotate the 

raster data as it is copied around the polar array. 

Center point of array: 

a. Select a point that represents the axis around which all selected 
data will be copied. 

Number of items: 

b. Enter the number of items that will fill the angle you will specify. 

Angle to fill (+=ccw,-=cw)<360>: 

c. Enter an integer value representing the angle over which the 
copies will be evenly distributed. 

Rotate objects as they are copied? <Y>: 

d. Respond Y to rotate the objects as they are copied. This will 
keep the raster objects in the same orientation to the center point as they 
are copied. Responding N will keep the raster objects in the same 
orientation as the original raster object selected.  

The raster data is copied. 
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gATTACH 

Type Menu Availability 
GA, GATTACH GTX Imaging>Quick Attach GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

gATTACH loads an image into BricsCAD with fewer steps than used in 
BricsCAD’s IMAGE command.  

Instructions: 

Select gATTACH. 

The gATTACH file dialog will appear. 

Select the appropriate file type in the “List Files of Type:” combo-box, 
select the directory in which the file resides. All files of the indicated type 
will appear in the “File Name” box. Select the file you wish to load and 
press OK. 

Loading a Raster File 

The image is attached at 0,0 and at the orientation specified by the 
AUTOROTATE configuration parameter. 

Raster Resolution 

If the GTXRAST.CFG setting is “FILE” the file’s resolution will be used, 
but if a specific resolution is set in GTXRAST.CFG, it will override that of 
the file. 

Color Images 

There is a difference in the way the gATTACH handles & opens color or 
black & white (binary) images. If you use the gATTACH command to 
open a 'color image' you will additionally be asked how you wish to pre-
process the color image 

 

The best command to use depends mainly upon the number of colors 
that your image has. 
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gBITONAL 

If you wish to automatically reduce a color image down to a simple binary 
image you can use gBITONAL The gBITONAL command has been 
optimized to operate on a broad range of color images & works well 
where an image has a clear-cut distinction between dark & light data.  

However, the gBITONAL threshold may not give the exact results that 
you desire (by including or omitting important data from the binary 
image). In these instances it may be better to use the gREDUCE & 
gSEPARATE commands, where you have greater control of the color 
separation & threshold.  

gREDUCE 

If you have an image with greater than 256 colors you can  use 
gREDUCE to bring the image down to 256 colors or less.  
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gSEPARATE 

For images with colors less that 256 colors, either before or after using 
reduction, you can use the gSEPARATE command. This allows you to 
accurately select colors, or groups of colors, & break then out into 
separate binary color images.  

These separate binary images can, if required, be further processed 
using the full range of GTX capabilities & commands detailed elsewhere 
in this help file. 

For more detailed information about each command's operation refer to 
the respective gBITONAL, gREDUCE & gSEPARATE section in the 
'Command Reference'. 

Cancel 

Cancel does no pre-processing & just loads the image into BricsCAD. In 
this state you cannot work on the color image using GTX commands. 

 

. 
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gAUTOSNAP 

Type Menu Availability 
GAS, GASP, GASNAP or 

GAUTOSNAP 

GTX Edit>Raster 

AutoSnap 

GTXRaster CAD 

GTXRaster CAD PLUS 

 

Icon:    

gAUTOSNAP enables BricsCAD’s AutoSnap™ options within an active 
image. 

Details: 

See “Snapping to Raster” in the Using GTXRaster CAD Series section 
for more details on using BricsCAD’s AutoSnap™ within raster images. 

Instructions: 

GAUTOSNAP: <0>,1: 

1. Type 1 to raster-enable AutoSnap™. 

2. Invoke BricsCAD’s OSNAP command.  The dialog includes a Select 

Settings section. 

3. Select the snap modes you wish to enable.  The BricsCAD Endpoint, 

Intersection, Intersection and Node settings activate GTX raster 

snaps.  Because BricsCAD does not provide “Edge” snapping, its 

Node snap is used to activate running edge raster snap. 

BricsCAD Object Snap GTX Raster Snap 
Endpoint Endpoint 

Intersection Intersection 

Nearest Nearest 

Node Edge 

Select OK. 

The aperture box will appear around the crosshairs and the marker will 
snap to raster features. 

Note: AutoSnap™ uses glyphs (symbols) to represent the snap type.  
GTX running snaps use ToolTip labels to identify the snap being 
used.  Snaps work instantaneously even though the ToolTips 
appear after a short delay. 
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gBURN 

Type Menu Availability 
GBU or GBURN GTX Convert>Burn All to Raster GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gBURN converts all vector entities into raster data with a designated line 
width. 

Note: The raster database must be established before gBURN can be 
used. The database can be established either by loading a raster 
file or by using gCREATE. If the database has not been 
established, you will see a message and gCREATE will be invoked 
automatically. 
Only entities within the raster limits can be rasterized! Those 
outside the limits will be ignored or erased. When entities are 
partially outside, the part inside is rasterized; the part outside is 
erased. 
All vector entities will be deleted when you use this command! 

Options: 

Width Options 

Table Use the width settings according to color as set in the Width 
Table 

Fixed Type in a value or select the width graphically using Box or Pick. 

Instructions: 

Dialog 

1. Invoke gBURN. The following 
dialog will appear. 

2. To specify line width you can a) enter 

a Fixed line width, b) specify it 

graphically by drawing a Box or by 

using Pick to select raster in the 

drawing of the desired width, or c) use 

a Table to correlate the colors of 

vectors to raster line widths. 

Fixed Line Width: 
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a. Select the Fixed radio button. Type the raster width to be used 
(in BricsCAD units, not pixels), or use the Pick or Box option to 
graphically specify the width. 

Using Box: 

a. Select the Box button. 

Select first corner of box: 

b. Select a point. 

Select opposite corner of box: 

c. As you move the cursor, a rubber-banding rectangle appears 
with one corner at the point selected. Move the cursor until the box is the 
desired width and the length exceeds the width. Select the point. 

The best way to use this feature is to pick a point on the edge of an 
existing horizontal or vertical raster line and stretch the box along the 
line. You can then easily match the width. The length of the rectangle 
can be any size that is longer than the width as the smallest side is used 
as the width measurement. A reference rectangle is used instead of a 
square to make it easier to see. As soon as the second point has been 
selected, the rasterization takes place. 

Using Pick 

a. Select Pick. 

Select raster <WIDTH>d 

b. Select a piece of raster data of the desired raster width. The 
width of the selected raster will be entered in the “Fixed” text box. 

Using the LineWidth Configuration Table: 

a. Select the Table radio button and the Table Setup button. The 
LineWidth Configuration Table appears, correlating BricsCAD color 
numbers and line widths expressed in current units. 

b. To change the width associated with a particular BricsCAD color, 
select that ACAD Color row. Enter the value in the Width text field. 
Select OK to close the dialog or select another row to change its width. 

Line Width Configuration Dialog 

Enter width <.XX>: 

c. Enter the value for the width in the units being used and press 
[RETURN]. The Width Table will reflect the changes. 
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d. Select another color number to change its width or press [0] and 
[RETURN] to continue the command. 

The entities will be changed to raster with the widths defined by their 
colors. 

The highlighted entities will be converted to raster. Some residual vector 
markings overlay the raster until you redraw the image. 

BricsCAD Prompts 

1. Invoke gBURN.  

Raster width Box/Pick/<Table>/.01: 

2. There are three ways to respond to this prompt. You can 1) type in a 

value as the width to be used for all vector lines to be rasterized for 

plotting; 2) use the LineWidth Configuration Table to correlate 

BricsCAD color numbers with line widths; or  3) use the Box or Pick 

options to specify a standard linewidth graphically (as described 

above). 

Fixed Line Width: 

a. You can type in a value (in mm or inch) as the width to be used 
for all the vector lines to be rasterized. The value in parentheses is the 
default value or one previously used. If you enter a value it will remain 
the default line width during this editing session. 

Note: If you defined the width previously in this session with a typed 
value or the “box” option, that value will appear as the default. You 
can press [RETURN] to accept this value or enter a number to 
represent the new width. The selected entities will all be converted 
to raster with the designated width. 

Using the LineWidth Configuration Table: 

a. If you type in “T” or “Table”, the LineWidth Configuration Table 
appears. The listing correlates BricsCAD color numbers and line widths 
expressed in current units. 

b. If you defined the width previously in this session with a typed 
value or the “box” option, that value will appear as the default. You can 
press [RETURN] to accept this value or enter a number to represent the 
new width. The selected entities will all be converted to raster of the 
designated width. 
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Note: The original default option is to use the Width Table set up by 
colors. This allows you to set different widths for entities being 
rasterized according to their color. If you press [RETURN] or [T], 
the Width Table will be displayed. The widths will be in inches or 
millimeters according to the unit set in GTXRAST.CFG. 

LINEWIDTH CONFIGURATION TABLE 

 

To change a line-width for different BricsCAD colors, enter the 

number for the entry. When you are satisfied with the settings, 

enter 0 to continue. 

 

BricsCAD Color #s Width in Inches 

0. To Continue 

1. Color 1 (Red)  .01 

2. Color 2 (Yellow) .01 

3. Color 3 (Green)  .02 

4. Color 4 (Cyan)  .02 

5. Color 5 (Blue)  .03 

6. Color 6 (Magenta) .03 

7. Color 7 (White)  .04 

8. Color 8   .08 

9. Color 21  .09 

10. Color 23  .10 

11. Color 30  .11 

12. Color 41  .12 

13. Color 63  .13 

14. Color 153  .14 

15. Color 201  .15 

16. Color 161  .16 

Enter the color number (1-16) of the width to change<0>: 

c. Enter the number and press [RETURN] 

Enter width <.XX>: 

d. Enter the value for the width in the units being used and press 
[RETURN]. The Width Table will reflect the changes. 

e. Select another color number to change its width or press [0] and 
[RETURN] to continue the command. 

Note: The width settings you change will remain in effect until you 
change them or you exit BricsCAD. 

The vectors will be burned to raster with the table’s widths. 

Note: Polylines and other non-filled entities that have a width attribute 
will be drawn with the BricsCAD width attribute. 
Rasterization of certain entities may take a while to process. 
Rasterizing text and ellipses takes longer than lines, for instance. 
Select less data at a time to improve rasterization speeds. 
You may need to zoom in to see line styles. 
This command does not work for 3-D entities. 
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gCALIKE 

Type Menu Availability 
GCA or GCALIKE GTX VClean>Calike GTXRaster CAD PLUS 

Icon:    

gCALIKE modifies the radius of circles or arcs to a specified radius or to 
match that of a selected circle or arc. 

Options: 

The circles can be changed in terms of a Reference circle or arc, a 
specified Radius or Diameter. 

Instructions: 

Select objects: 

1. Select one or more circles and/or arcs that you will want to set to 

identical radii. 

Select reference circle or arc: 

2. Choose a circle or arc with the desired radius. 

Enter Diameter <Radius> <#.##>: 

3. The reference object’s radius will appear in the angle brackets.  A 

rubber banding line stretches from the center of the reference object 

to the cursor.  Press [RETURN] to accept the value, graphically 

select with the left mouse button the desired radius, type a new 

desired radius value, or type D and then enter a new diameter. 
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gCARC 

Type Menu Availability 
GCARC GTX GTX Edit>Change Arc GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

The gCARC command stretches arcs. Change the radius of an arc by 
moving its circumference and endpoint. This command also merges or 
smoothes fragmented and irregular arcs. To smooth, choose the raster 
entity and redraw it without changing its geometry. 

Arc selection requires 5 point selection 

Command: gcarc 

Select start point of reference arc:  (point #1) 

Select point on arc:  (point #2) 

Select end of reference arc:  (point #3 - the selection is highlighted) 

Select new circumference point:  (point #4 - keep or move the point) 

Select new endpoint:  (point #5) 

Select start point of reference arc:  (The command is ready for a second 
arc selection. Press the return key or escape key to terminate the 
command.) 
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gCCIRCLE 

Type Menu Availability 
GCCIRCLE GTX Edit>Change Circle GTXRaster CAD 

GTXRaster CAD PLUS 

 

Icon:  

The gCCIRCLE command stretches raster circles. Change the radius of 
a circle by moving its circumference. This command also merges or 
smoothes fragmented and irregular circles. To smooth, choose the raster 
entity and redraw it without changing its geometry. 

Circle selection requires 4 point selection 

Command: _gccircle 

Select point on circumference of circle:  (point #1) 

Select second point for circle:  (point #2) 

Select third point for circle:  (point #3 - the selection is highlighted) 

Current radius is ### 

Enter circle radius: (point #4 or a numeric value may be typed) 

Select point on circumference of circle:  (The command is ready for a 
second circle selection. Press the return key or escape key to terminate 
the command.) 
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gCCIRCLE2P 

Type Menu Availability 
GCCIRCLE2P GTX Edit>Change 2P Circle GTXRaster CAD 

GTXRaster CAD PLUS 

 

Icon:  

The gCCIRCLE2P command stretches raster circles. Change the radius 
of a circle by moving its circumference. This command also merges or 
smoothes fragmented and irregular circles. To smooth, choose the raster 
entity and redraw it without changing its geometry. 

Circle 2P selection requires 3 point selection 

Command: _gccircle2p 

Select point on circumference of circle: (point #1) 

Select second point for circle: (A vector circle is stretched over the raster 
circle to point #2. The selection is highlighted)  

Current radius is ### 

Enter circle radius:  (point #3 or a numeric value may be typed) 

Select point on circumference of circle:  (The command is ready for a 
second circle selection. Press the return key or escape key to terminate 
the command.) 
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gCELEV 

Type Menu Availability 
GCE or GCELEV GTX VClean>Contour Elevation GTXRaster CAD PLUS 

Icon:    

gCELEV sets the elevation of a series of PLINE objects in increments. 

Instructions: 

Set the base or starting elevation. 

Set the Contour Interval – the increments by which elevation is changed. 

Press OK. 

Stop/<Pick Contour>: 

Select the polyline to assign the starting elevation. 

Stop/<Pick Contour>: 

Select the polyline to assign consequent elevations. 

When done, type S. 
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gCHANGE 

Type Menu Availability 
GCH or GCHANGE GTX Edit>Change GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:    

gCHANGE stretches raster lines, arcs and circles. Change the radius of 
an arc by moving its circumference and endpoint. Change the radius of a 
circle by moving its circumference. Change the length and orientation of 
a line by moving one endpoint. 

This command also merges or smoothes fragmented and irregular lines 
or arcs. To smooth, choose the raster entity and redraw it without 
changing its geometry. To smooth or merge entire sections of a drawing, 
use the gSMOOTH command. In the following illustrations, dashed lines 
portray rubber-banding lines. 

Options: 

Object Type  Options 

Line Select a line to be changed. 

Arc Select an arc to be changed. 

Circle Select a circle to be changed. 

Instructions: 

1. Select gCHANGE. 

Select raster <LINE>: 

2. The original default is “line”. If you want to select another type of 

object, select it from the menu or type the first letter of the name. 

Using Line 

a. Select a point on the raster line to serve as the endpoint that will 
NOT change. Then select a point to indicate the rest of the line that will 
be altered. The raster line will be highlighted and a rubber-banding 
reference line will appear, attached at the first point used to pick the line 
(If the first point was outside the raster line, the endpoint closest to that 
point is selected). 

Select new endpoint: 
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Note: If you choose points to change a raster line drawn in a broken or 
dashed line style, all the segments will be selected, but the new 
line will be redrawn as a smoothed, solid line.  
Turn on the Ortho Mode ON if you want to change lines so they are 
perfectly horizontal or vertical or so they snap to a specified angle. 

b. Move the cursor. The reference line will rubber band as it follows 
the cursor. Press [SELECT] to select the new point where the line 
should end. The reference line will disappear and the raster line will be 
redrawn at the new orientation and length. 

Using Arc 

a. Select the endpoint that will NOT change. Then select a point on 
the circumference of the arc and the other endpoint of the arc. These 
three points define the raster arc and the selected arc will be highlighted. 

Select new circumference point: 

b. You will see a rubber-banding line extending from the first 
endpoint selected. Select a point to be on the circumference of the new 
arc. 

Select new endpoint: 

c. The rubber-banding line will be attached at the second point. 
Select the endpoint for the new arc in any of the usual ways. The raster 
arc will be redrawn through the three points. If the original arc was in 
several pieces, they will be selected but the new arc will be solid. 

Using Circle 

a. Select the “circle” option from the menu. 

Select point on circumference of circle: 

b. Specify the raster circle by selecting three points on the 
circumference. After the raster circle has been selected, it will be 
highlighted. A rubber-banding line from the center of the circle will 
appear. 

Enter circle radius: 

c. Enter a value in current units or select a point to indicate the 
radius of the new circle. The circle will be redrawn with the original center 
point and the new radius. 

Note: If the original circle was broken into arcs or drawn in a dashed line 
style, they will be selected but the new circle will be unbroken. 
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gCHGLAY 

Type Menu Availability 
GCHGLAY 

GCHL 

GTX VClean>Change Layer GTXRaster CAD PLUS 

Icon:    

gCHGLAY changes the layer of objects to that of a specified object. 

Instructions: 

Select Objects to Change Layer: 

1. Select the objects you want to move to a destination layer. 

Dialog/<Select object on NEW layer>: 

2. Either type D to select a layer or to define a new layer, or select a 

sample object that is already residing on the desired destination 

layer. 

If you selected a sample object, the selected objects are moved to the 
same layer as the sample.  If you selected dialog, continue reading the 
following instructions: 

The Manual Layer Selection dialog appears. 

3. Select the destination layer name from the list or select New Layer 

to define a new destination layer for the selected objects. 

4. When done, select OK. 

The selected objects are moved to the specified layer. 
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gCIRCLE 

Type Menu Availability 
GCIRCLE 

GC 

GTXEdit>Draw Circle GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

Draws a raster circle in the current raster image 

Instructions: 

gCIRCLE 

Center Point: 

Select (or type) the centerpoint of the circle. 

Radius [Diameter]:  

Select (or type) the radius, or type "D" and then specify the Diameter. 

The circle appears after the radius or diameter is specified. 

Note: If there is no active image, gACTIVE will be invoked before 
continuing with gCIRCLE.  If there is no image attached gCREATE will 
be invoked to set up an image into which raster line can be drawn. 
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gCLEANIOP 

Type Menu Availability 
GCLEANIOP GTXEnhance>Clean IOP GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gCLEANIOP deskews the image and removes noise and speckles. 
gCLEANIOP creates a selection set of all noise.  You can use ADD and 
REMOVE in combination with other IOP methods to refine the selection 
set.  When finished, the command deletes the highlighted raster. 

Instructions:  

The image automatically deskews and noise is highlighted. 

Select Raster <WINDOW>: 

Add or remove raster using standard IOP methods. When done adding 
and removing raster, press [RETURN]. 
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gCLINE 

Type Menu Availability 
GCLINE GTX Edit>Change Line GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

The gCLINE command stretches raster lines. Change the length and 
orientation of a line by moving one endpoint. This command also merges 
or smoothes fragmented and irregular lines. To smooth, choose the 
raster entity and redraw it without changing its geometry. 

Line selection requires 3 point selection 

Command: _gcline 

Select one end of reference line:  (point #1) 

Select other end of reference line:  (point #2 - the selection is 
highlighted) 

Select new endpoint:  (point #3) 

Select one end of reference line:  (The command is ready for a second 
line selection. Press the return key or escape key to terminate the 
command.) 
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gCONCEN 

Type Menu Availability 
gCONCEN or GCONC GTX VClean>Concen GTXRaster CAD PLUS 

Icon:    

gCONCEN moves circles and arcs to be concentric about a location or 
about the centerpoint of a specified circle or arc. 

Instructions:  

Select Objects: 

1. Select one or more circles or arcs 

Pick point/<Select circle/arc>: 

2. Select another arc or circle about which the previously selected 

objects should become concentric.  Alternatively, type P and select 

the location itself. 

The selected objects are moved so their centerpoints align about the 
centerpoint of the target object or about the indicated location. 
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gCONVRT 

Type Menu Availability 
GCO or GCONVRT GTX Convert>Vectorize GTXRaster CAD PLUS 

Icon:    

gCONVRT converts raster data to BricsCAD vector geometry.  

Instructions: 

Conversion Type 

CAD conversion, raster data is 
converted into lines, arcs, circles 
and “arrowheads” (triangular SOLID 
entities). This option is best for 
mechanical drawings and line 
diagrams. 

Contour causes raster data to be 
converted into polyline or spline 
entities. This option is best for maps 
and other documents containing 
contours. 

Rectify 

Ortho: Improve the drawing by 
making cleaner intersections; 
snapping lines to horizontal or 
vertical. Where applicable, fillet arcs 
are snapped to increments of 90 
degrees, producing a high quality 
filleted corner. 

Reference snaps lines that are close to a specified reference angle to 
that angle.  Parallel lines at this angle separated by a distance close to 
the offset distance are snapped to that distance. 
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1. Select Reference. 

First point for snap angle: 

2. Select the first point for the angular line. 

Second point for snap angle: 

3. Select the second point to define the angle. 

Reference angle <XX.XXXXX>: 

4. You can type in a new value for the angle or press [RETURN] if it is 

satisfactory. You cannot redefine it by selecting points. 

Parallel alignment offset <0.0>: 

5. This value determines the distance between the imaginary grid lines 

parallel to the given reference angle. Type in a value in current 

drawing units. Using the (0.0) value which is always the default 

means no grid snapping for this angle. 

First point for snap angle: 

6. You can define another reference angle and grid or press [RETURN] 

if you don’t want to use another one. When you are finished defining 

the angles, press [RETURN]. The command then continues as 

above. 

Note: If you use the Reference Angle option, orthogonal rectification will 
not occur automatically. However, you can enter “0” and “90” 
reference angles to achieve orthogonal rectification. 

None converts raster exactly as it appears without any rectification. 

Vector Color 

BricsCAD vector entities don’t have any width. You can preserve 
information stored in the line width of the raster image; you can assign a 
color to vectors resulting from different line widths. 

By Width causes the values in the line-width configuration table will be 
used to determine the color of the vector entities. Table Setup displays 
the table and values can be changed if desired. If several colors are 
given the same width value, only the lowest number color will be used for 
that line width. 

1. Select the No Widths check box to render resulting vectors in the 

current BricsCAD layer’s color or select the Table Setup button to 

color-code resulting vectors for up to 16 different line widths. 
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Line Width Configuration Table 
Dialog2. Click on the color to 
modify a color’s width value. Enter 
the new 

 value in the Width input window at 
the lower right corner.  

Note: If you set your BricsCAD 
display options so that the 
background of the screen is 
white, the Line Width 
Configuration Table’s “white” 
color (color #7) will refer to 
black vectors. 

3. Select another color to change or 

click OK to exit the Line Width Configuration dialog. 

Leaving By Width inactive causes resulting vectors to inherit the color 
and linestyle of their layers. 

Hatches 

When this is active, vectors generated from hatched areas will be 
isolated on their own BricsCAD layer. The name for this layer is 
established by the Hatch_Layer_Name configuration parameter in 
GTXRAST.CFG.  You can create this layer in advance in your drawing 
template and give it a color if you always want hatched data to appear 
the same. 

Hatch angle? <0.000>/Pick: 

1. Type the hatch angle or type P to select two points designating the 

angle. 

Parallel alignment offset <0,0> 

2. Type the distance between hatches or select two points designating 

the distance. 

Hatch angle? <45.000>/Pick: 

When done, press [RETURN]. 

Parallel alignment offset <0,0> 

Press [RETURN] again. 
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Linestyles 

When this is active, lines that appear to have regular breaks in the raster 
image will be isolated on their own BricsCAD layer. The name for this 
layer is established by the Linestyle_Layer_Name configuration 
parameter in GTXRAST.CFG.  As with Hatch_Layer_Name, you can 
create this layer in advance in your drawing template and give it a color 
and linestyle if you always want hatched data to appear the same. 

Arrowheads 

Controls whether arrowheads (3-sided solids) are generated during CAD 
type conversion. 

Linear alignment 

Linear Alignment causes broken lines to be merged into unbroken lines 
as they are vectorized.  This is used to convert dashed geometry as a 
single entity (then the entities can be moved to a dashed BricsCAD 
layer). If this box is empty, collinear geometry with gaps or breaks will be 
vectorized without closing the gaps.  The gap is established by the Gap 
Jump setting. 

Gap Jump 

Sets the distance in pixels for Linear Alignment to jump when 
combining multiple collinear lines into single lines (as in recognizing 
dashed linestyles). This can be set by manually entering the distance or 
by selecting Pick Gap and then graphically showing a gap distance. 

Other Options 

Save Raster preserves raster data after converting it to vector.  If this 
box is empty, the raster will be erased after conversion. 

Elevation sets the elevation at which resulting vectors will be created. 
The default value is 0. To create contours at different elevation, set this 
value before converting raster to vector. 
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Elevation 

Set the Elevation to the level at which resulting vectors should be 
created (normally you want this to be 0). 

When all parameters are set as desired, click OK to launch the 
conversion process. 

Prompt Mode 

gCONVRT also works exclusively with BricsCAD prompts when the 
CMDDIA variable is set to 0. 
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gCOPY 

Type Menu Availability 
GCP or GCOPY GTX Edit>Copy GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:    

gCOPY copies raster data from one location to another location in the 
image entity. 

Options: 

Movement Options 

Base Point Indicate the offset distance for the copy by selecting two 
points. 

Note: Turn the ORTHO Mode ON to place copies in a perfectly horizontal, 
vertical, or specified direction from the last position. 

Displacement Enter X and Y offset values to indicate copy placements. 

Instructions: 

1. Select gCOPY. 

Select raster <WINDOW>: 

2. Select the raster to be copied. The selected raster will be highlighted.  

3. When all of the raster to be copied is highlighted, press [RETURN]. 

Base point or displacement: 

There are several ways to respond to this prompt. To use the default 

option, either select a reference point or type in how far over the 

selected data should be copied. Since the system does not know 

whether X,Y value typed in this is the base point or the displacement 

distance, the response to the second point clarifies this. 

Using Base Point 

a. Select a base point either by using the cursor or by typing the 
coordinates. This will be a reference point for the copy process. 

Second point of displacement: 
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b. A rubber-banding line will appear attached at the base point. 
Select a second point to define the relative distance and angle for 
placement of the copy. The copy will appear in the designated location in 
the display raster color. The original raster will be un-highlighted. The 
command will terminate. 

Using Displacement 

a. At the “base point or displacement” prompt, type in the X and Y 
value for the displacement in the same format used to enter coordinates. 
You will see the same prompt as above. 

Second point of displacement: 

b. Press [RETURN] to indicate that the original entry was the 
displacement. The raster data you selected will be copied to its new 
location in the main raster color. The original raster will be un-
highlighted. The command will terminate. 
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Copy All Images 

Type Menu Availability 
gCAI GTX Imaging>Modify Images>Copy All Images GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:    

Copy All Images invokes BricsCAD COPY command on all image 
entities. 
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gCREATE 

Type Menu Availability 
GCR or GCREATE GTX Imaging>Create GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:    

gCREATE establishes an unnamed raster image entity on the current 
BricsCAD layer. The raster data can be modified within the limits, which 
can be changed later using the gRESIZE command. 

The MaxNumPixels configuration parameter limits the number of pixels 
allowed in a new raster image. The default value is: 

MaxNumPixels=973440000 

which at 400 dpi could generate an image measuring 78” x 78”. 

Instructions: 

1. Select gCREATE. 

Enter raster resolution DPI <200>: 

2. Enter a positive integer. 

select lower left corner of raster limits <0.000,0.000>: 

3. Normally, you enter “0,0” for this value. However, you can select any 

point either by typing coordinates or selecting it graphically. 

Select upper right corner of raster limits: 

4. A rubber-banding box will appear attached at the first point. Select 

the point for the upper right corner either with coordinates or 

graphically. 

Warning: When creating a new raster image in a hybrid environment, 
consider the drawing’s scale. Raster images will normally be 
about the same size as paper media. Create images at “paper” 
size and then scale them against your vector data. You don’t 
want to create a raster image the size of a house or a map - it will 
take a long time if it works at all! 

5. The program will check whether there is sufficient memory for the 

work area you designate. If not, you will get an error message. 
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gCROP 

Type Menu Availability 
GCRO or GCROP GTX Enhance>Crop GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:    

gCROP Deletes all raster data outside of a specified rectangular window. 
For instance, you may use it to get rid of “dirty” edges or an unwanted 
frame.  

Instructions: 

1. Select the gCROP command. 

Select first corner of window: 

2. Select a point for one corner of the window. 

Select opposite corner of window: 

3. A rectangular window will rubber-band from the first point selected. 

Position it to include all the raster data you want to save. Press 

[SELECT] to select the point. 

Note: If your drawing is skewed or rotated, use gDESKEW first. 
To reduce the raster limits by eliminating the outside area, use 
gRESIZE or use the gCUT command to create a new file. 

The raster data outside the window will disappear. The raster limits stay 
the same. 
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gCTEXT  

Type Menu Availability 
GCTEXT GTX Edit>Change Text GTXRaster CAD 

GTXRaster CAD PLUS 

 

(Change Text) 

Icon:   

The change text feature begins by framing an area of the current raster 
image that contains raster text data that is to be replaced by new raster 
text. The framed area is defined by a baseline at any orientation angle 
and the replacement raster text will be drawn at that angle. The 
replacement text is entered with the aid of the Text Formatting control.  

 Instructions: 

1. Select insert point of baseline             
             The point chosen will be the lower left point of the first    
  text character of the replacement raster text. 

 

          

  

 

 

 

 

2. Select end point of baseline                                                    
              This point defines the width of the existing raster data that 
              will be replaced by either new raster text or blank space. 
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 3.Select rectangle height                                                                
           This point completes the frame of raster data that will be 
            replaced by new raster text or blank space. 

 

All raster data contained within the framed area will be highlighted. All 
highlighted raster data will be removed and replaced by the following 
steps. 

4.Specify new text height                                                                           
Enter a numeric value that will set the height of the new raster text.  The 
height of the existing raster text may be determined ahead of time by 
using the Dist command.  

  

 

 

 

 

5. The Text Formatting control with the In-Place Text Editor will appear. 
    Type over the raster text that was highlighted in step #3. 
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     .  

  

6.To end the editing click the OK button on the Text Formatting toolbar 
    or click outside the In-Place Text Editor. 

                 

 

  

  

 

 

gCtext Advanced Instructions:  
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The change text command provides the choice of multiple IOP 
(intelligent object picking) selections on any part of the raster data in the 
current image object, however only the area of the data highlighted by 
the baseline and height framing is subject to editing of raster text. Any 
other highlighted raster will be erased when the gCtext command has 
completed. 

 In this example the editable text in the following images is the word 
BRACKET. That word was framed using the baseline and height 
selection. The two text lines at the bottom of this example were 
subsequently highlighted using an IOP selection, in this case the Inside 
selection. 

 This is the sequence gCtext command responses that complete this 
example; 

 Command: gctext  

Select insert point of baseline: 

Select end point of baseline: 

Select rectangle height: 

 

The word BRACKET was framed by a baseline and height point. 

  

 

 

Select raster <INSIDE>: 

../../AppData/Local/2012%20RCAD/2012UM/Help%20FilesGTXRaster%20CAD%20V13Raster_Picking_Options.htm
../../AppData/Local/2012%20RCAD/2012UM/Help%20FilesGTXRaster%20CAD%20V13Raster_Picking_Options.htm
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Select opposite corner of window: 

 

           The last two lines of text were selected and highlighted by the 
            Inside IOP 

 Select raster <INSIDE>:        

Multiple IOP choices on other sections of raster data are                      
allowed. Press the keyboard Return to escape further picking  
choices 

 Specify new text height  

 

The In-Place Text Editor opens and the word BRACKET is edited. 
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To end editing click the OK button on the Formatting toolbar or click 
outside the In-Place Text Editor 

  

 

The word BRACKET has been changed and all IOP selected raster data 
is removed. 
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gCUT 

Type Menu Availability 
GCU or GCUT GTX Edit>Cut GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:    

gCUT copies raster data from the active image entity to a raster file or to 
memory. The default filename is set in the configuration file. 

Note: 1. Raster data cut from images is oriented relative to the raster 
file’s coordinate system. When cutting raster data from a rotated 
image entity, the raster is not necessarily saved as displayed 
within BricsCAD. Also, when pasting raster data into a rotated 
image, the raster data appears at the image entity’s native rotation. 
2. If the “raster limits” box does not enclose all of the highlighted 
raster data, the data outside the rectangle will not be saved in the 
file. 
3. If the rectangle does not fall entirely within the raster limits, the 
limits will be used instead of the point(s) selected. 
If you want to save the file with a format other than the one 
specified in the GTXRAST.CFG file, type in the extension that 
defines that format. 

Options: 

Mode Options 

Copy Copy the data and retain it on the screen. 

Erase Copy the data and erase it from the drawing. 

Destination Options 

File Copy the data to a raster file. 

Buffer Copy the data to a temporary buffer (to be gPASTE-d later). 

Instructions: 

1. Select gCUT. 

Command: gCUT 

Mode <Copy>/Erase: 

2. The default value is in brackets. Press [RETURN] to select the 

default or select the desired mode from the menu or by entering its 

abbreviation. 
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Select raster <WINDOW>: 

3. Select the raster data. 

4. Press [RETURN] when all the raster data to be saved in the new file 

has been highlighted. You will next be prompted to define the image 

limits. 

Select lower left corner of raster limits: 

5. Type in the coordinates for the point or position the cursor and press 

[SELECT]. A rubber-banding box will appear attached at the point. 

Select upper right corner of raster limits: 

6. Select the point for the upper right corner of the limits. The two points 

you have selected are stored as the upper and lower limits of the 

image. 

File/<Buffer>: 

7. Enter B to copy the data to a temporary raster buffer. The selected 

data within the rectangle will be copied to a raster buffer for later 

insertion using gPASTE. Enter F to save the selected data to a 

raster file (Continue with step 8). 

Dialogs: 

a. After specifying F or File, gCUT will save the selected data to a 
raster file. gCUT will display the SAVE Raster File dialog. 

Enter the desired file name and select the appropriate path for the new 
file. 

b. To change the default file type, select the scroll box labelled “List 
Files of Type:” and select the desired file format.  

c. The file name entered does not need to include the extension. 
The file type extension displayed in the List Files of Type: box will be 
used. 

d. Click OK to return to the drawing editor. 

Prompts: 

a. After specifying F or File, gCUT will save the selected data to a 
raster file. gCUT will display the following prompts: 

Enter raster file name <cut_data.ext>: 
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b. The default file name is “cut_data” with the extension indicated in 
the GTXRAST.CFG file. If you have previously used gCUT, the name of 
that file will be the default shown in brackets. Accept the default file 
name by pressing [RETURN] or type a new name for the raster file and 
press [RETURN]. 

If you do not include the extension, the format and extension set in the 
GTXRAST.CFG by “RasterFormat” and “RasterSaveExt” entries will be 
used. If no path is indicated, the file is saved using the path defined in 
the GTXRAST.CFG “RasterPath” entry. If no path was defined, it is 
saved in the current directory. 

c. If a file already exists with the same name you typed as a new 
name, you will be asked whether to replace it. If you respond “yes”, the 
new file will overwrite the old one. If you accept the default, “No”, you will 
again be prompted for a raster file name. The request is repeated until 
an acceptable name is entered or you cancel the command without 
saving a file. 

d. When a file has been saved, the highlighting will disappear. If the 
“erase” mode was selected, the highlighted data will also disappear. 
Otherwise the raster data remains as it was before the command was 
invoked. 

Raster file FILENAME.EXT saved. 
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gDESKEW 

Type Menu Availability 
GD or GDESKEW GTX Enhance>Deskew GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:    

Drawings are often scanned in slightly rotated. gDESKEW straightens 
selected raster by rotating it to align with the X or Y axis.  

The gADESKEW (Auto Deskew) command may be faster and easier 
with drawings that have titleblocks. 

The deskew uses reference line that is rotated to horizontal or vertical 
(whichever is closer). Pick points as far apart as possible. Use 
transparent zoom or raster snapping features to draw the reference line 
precisely. 

The lower left corner is used as the rotation point. 

Processing time depends on image size, and resolution, and available 
memory. 

Instructions: 

1. Select gDESKEW. 

Command: gDESKEW 

This command could fail in limited memory situations 

Do you want to save the raster image first? Yes/<No>: 

2. If you have adequate memory for the file you are using or have 

already saved the data, press [RETURN]. Otherwise, it is a good 

idea to respond “Yes”. GTXRaster CAD will then invoke gSAVE, you 

will save the data and gDESKEW will continue. 

Select raster <WINDOW>: 

3. Select the raster data to deskew. If deskewing the entire drawing, 

type: ALL. Press [RETURN]. 

Select one end of reference line: 

4. Select a point on a raster line that should be perfectly horizontal or 

vertical. A rubber-banding reference line will extend from it to the 

cursor. 

Select other end of reference line: 

5. Move the cursor to the second point on the line and select it. The 
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deskew will take place, based on the reference line you indicated. 

You will see a message: De-skewing XX.XXXXXX degrees. 

Do you wish to displace deskewed raster? Y/<N>: 

6. If the raster is located correctly, press [RETURN]. The command will 

be completed. If you wish to move the deskewed raster, type: Y. 

Base point or displacement: 

There are two ways to respond. You can either select the first of two 
points that will show the movement graphically or type in the offset 
values in the form X,Y. Since the system does not know whether the X,Y 
value typed in is the base point or the displacement distance, the 
response to the second prompt clarifies this. 

Using Base Point 

1. Select the reference point for the moving process. 

Second point of displacement: 

Note: 1. If you skew the same file several times the raster data could 
become distorted. If this happens, re-load the raster image and 
deskew it again using gDESKEW once. 
2. If the image needs to be rotated more than 5 degrees you should 
re-scan the drawing. Deskewing the entire image more than a few 
degrees can distort the raster data. 
3. Large files may take several minutes to complete the operation. 
Using transparent zoom or the “end” or “int” raster snapping 
methods can help you more accurately pick your reference line. 

2. A rubber-banding line will appear attached at the base point. Select a 

second point to define the relative distance and angle for the new 

placement of the deskewed raster. It will appear in the designated 

location. The command will be completed. 

Using Displacement 

1. Type in the X and Y values for the displacement in the same 
format used to enter coordinates. You will see the same prompt as 
above. 

Second point of displacement: 

2. Press [RETURN] in response to the prompt to indicate that the 

original entry was the displacement. The deskewed raster will appear 

in the new location. 
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gDETACH 

Type Menu Availability 
GDETACH GTXImaging>Detach Raster Image GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

Removes the selected image definition from the drawing database and 
erases an image object from the drawing and from the display. If there is 
only a single image object defined in the drawing it will be removed in a 
single step. The GTX Image Selection control is presented if there are 
more than one image objects defined in the drawing. A single image 
must be selected for detachment. 
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DrawOrder Back 

Type Menu Availability 
GDRO_BK GTX Imaging>Modify>Send Images to Back GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:    

DrawOrder Back Moves all raster image entities’ draworder to back using 
BricsCAD’s DrawOrder command. 
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gECONVRT 

Type Menu Availability 
GEC or 

GECONVRT 

GTX Convert>Vectorize Edge GTXRaster CAD PLUS 

Icon:    

gECONVRT converts raster data to BricsCAD vector geometry. 

Options: 

Contour When checked, raster contours are converted into polyline 
entities, which are good for designating contours. When this checkbox is 
empty, raster data is converted into lines, arcs, and circles. 

Save Raster Retains raster after conversion to vector. If this box is 
empty, the raster is erased during conversion. 

Elevation Sets the elevation at which resulting vectors will be 
created. The default value is 0. To create contours at different elevation, 
set this value before converting raster to vector. 

Instructions: 

1. Invoke gECONVRT.  

Specify raster <WINDOW>: 

2. Select the desired raster and press 

[RETURN]. The Edge Convert 

Setup dialog will appear: 

Width Recognition 

The edge of a solid raster area has no 
width, so this option is disabled. 
Proceed to the conversion type. 

CAD or Contour Conversion: 

3. Checking the Contour box will cause lines and polylines to be 

generated. Leaving this box un-checked will cause only lines, arcs 

and circles to be generated. 
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a. If the Contour option is checked, the Polyline Smooth Index 
input window will contain a value between 1 and 9. A value of 1 would 
follow the contours least smoothly, and 9 results in the closest match to 
the contour. 

With lower resolution images you may want to choose values lower than 
8 or 9 so that the polylines don’t follow the square contours of individual 
pixels! 

4. Set the Elevation to the desired level at which resulting vectors will 

be created. 

5. Set Save Raster to your preference 

6. Select OK to start the conversion. 
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gEDGE 

Type Menu Availability 
GED or GEDGE GTX Enhance>Edge GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

gEDGE removes the inside of solid raster regions, leaving only the edge. 
Removes all raster except a single pixel width contour around the edge 
of selected raster data. 

Instructions: 

Command Dialog: 

1. Invoke gEDGE. 

Select raster <WINDOW>: 

2. Select the raster you wish to “hollow out”. Press [RETURN]. 

3. The insides of the raster are erased, leaving a 1-pixel edge around 

the outside. 
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gERASE 

Type Menu Availability 
GE or GERASE GTX Edit>Erase GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gERASE removes selected raster data from the drawing. 

Instructions: 

1. Invoke gERASE. 

Select raster <WINDOW>: 

2. Select the raster you want to remove.  

3. When all the raster data to be removed is highlighted, press 

[RETURN]. The selected raster is then erased. 
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gFRZLAY 

Type Menu Availability 
GFR or 

GFRZLAY 

GTX VClean>Freeze Layer GTXRaster CAD PLUS 

Icon:    

gFRZLAY freezes the layer of a selected object. 

Instructions:  

Dialog/<Select object>: 

Choose an object residing on the layer you wish to freeze or type D to 

use the dialog. 

Object: 

The layer of the selected object becomes frozen. 

Dialog: 

A dialog appears.  Choose the layer or layers to freeze and select OK. 
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gHELP 

Type Menu Availability 
GH or GHELP GTX Imaging>Help GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:    

gHELP starts the GTXRaster CAD Help file. The Help window functions 
as any other Windows application Help file, including “search for 
keyword” capabilities. 

The Help file can also be executed from the GTXRaster CAD Help icon 
in the GTX program folder. 

For more information on available sources of help, refer to the 
Introduction. 
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gHTEXT 

Type Menu Availability 
GHTEXT GTXConvert>Edit Hybrid Text GTXRaster CAD 

GTXRaster CAD PLUS 

 

(Edit Hybrid Text) 

Icon:   

The gHtext command begins with the selection of a vector text object. 
The command can edit any DTEXT or MTEXT entity or hybrid text that 
was created by using the gText command while the gHybridmode 
function is enabled. Hybrid text is raster text with a vector text overlay. 
The final result of text editing with the gHtext command will be hybrid 
text. If vector text is selected and there is no attached raster image then 
a raster image will be created by an automatic start of the gCreate 
command.  Edited hybrid text will be oriented at the same angle as the 
text that is chosen to be edited. The gHtext command initiates a vector 
text editor aided by the Text Formatting control. 

 Instructions: 

Command: ghtext 

1.Select text object: 

           Mouse click on the vector text to be edited.  

 2.Selection of a vector text string opens the Text Formatting control with 
the In-Place Text Editor. 
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3.Place the cursor at the point where text is to be added or deleted. Type 
new text or swipe over existing text to delete. 

 

  

4.When editing is complete, click the OK button on the Text Formatting 
   control or click somewhere outside of the In-Place Text Editor. The 
   changed hybrid text is completed. 
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gHYBRIDMODE  

Type Menu Availability 
GHYBRIDMODE GTXConvert>Hybrid Mode GTXRaster CAD 

GTXRaster CAD PLUS 

 

Icon:  

Enabling the hybrid mode will result in a vector overlay of raster that is 
drawn using any of the GTX raster drawing commands   Hybrid mode 
value 1 is enabled and value 0 is disabled.    

Command: ghybridmode 

 HYBRIDMODE: <0>,1 : 
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Image Frame 

Type Menu Availability 
ImageFrame GTX Imaging>Modify Images>Image Frame GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

ImageFrame sets frames for all image entities to on or off. Sets the 
BricsCAD ImageFrame variable. 

 

 

 

 

 

Image Transparency 

Type Menu Availability 
Transparency GTX Imaging>Modify Images>Image Transparency 

On 

GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

Transparency makes all images transparent when selected from the 
Imaging toolbar. Otherwise lets you set the transparency mode for 
selected images. 
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gINACTIVE 

Type Menu Availability 
GINA or 

GINACTIVE 

GTX Imaging>Deactivate Image GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gINACTIVE deactivates the active image entity, freeing memory. In order 
to edit the image you must reinvoke gACTIVE and choose the image. 
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gINFO 

Type Menu Availability 
GI or GINFO GTX Imaging>Info GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

gINFO displays details about the current raster image and the software 
license. It includes the default values for raster file name and format, as 
well as the resolution, the raster limits and data extents (in current 
drawing units). The file name and format will be that of the last raster file 
loaded or saved. 

Instructions: 

1. Select gINFO. You will see a listing on the text screen display 
similar to the following. The values shown are sample values only. 

Resolution: Shows the resolution of the current raster database in 
terms of dots per inch (DPI). This value is obtained from the resolution 
from the file unless overridden by the GTXRAST.CFG Resolution 
setting or by a resolution established using gCREATE. 

Raster data limits: Defines the rectangular area indicating the size 
of the present raster image, including bounding white space, set with 
gCREATE or gRESIZE or by the limits of the raster drawing that was 
loaded. The values are given in current drawing units. 

Raster data extents: Defines smallest rectangular area that can 
enclose the raster data in terms of BricsCAD units. It is defined by the X 
and Y coordinates of the lower left corner, followed by the X and Y 
coordinates of the upper right corner of the rectangle. The extents 
determine where raster data is currently drawn. 

Drawing limits: Defines the BricsCAD drawing limits. 

Source FileName: The name of the raster file to which the image 
refers. 

Active FileName: The filename to which gSAVE will save. 
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Raster File type: This reflects the format of the last raster file 
saved with gSAVE or the setting in GTXRAST.CFG if no file has been 
saved yet. 

Undo store size: Number of raster undo’s being recorded. 

Image modified? Flag identifying whether image has been 
changed since the last save (TRUE or FALSE). 

Version: Shows GTX program, version number, and ARX version 
of the GTX program that is running.  
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gINVERT 

Type Menu Availability 
GIN or GINVERT GTX Enhance>Invert GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:    

gINVERT Reverses the background and main raster colors of the current 
raster image. Use it on files scanned in reverse (light on dark). This does 
not just invert the display of an image - it truly inverts the raster image 
itself. 

Instructions:  

The color of the background and the color of the data will be switched. 
You can then edit the raster data with any of the GTXRaster CAD 
commands. 

Undo gINVERT by invoking the command again. 
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gISOLAY 

Type Menu Availability 
GISL or 

GISOLAY 

GTX VClean>Isolate Layer GTXRaster CAD PLUS 

Icon:    

gISOLAY freezes all layers except that of the selected object, effectively 
isolating its layer. 

Instructions: 

Select objects: 

Select objects on the layer or layers you want to isolate. 

Press [RETURN]. 

The layers of the objects chosen in step 1 are isolated by freezing all 
other layers. 
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gJOIN  

Type Menu Availability 
GJO or GJOIN GTX VClean>Join GTXRaster CAD PLUS 

Icon:    

gJOIN joins vector lines together. 

Instructions: 

Select line startpoint. 

Select the endpoint of the line you wish to join with another line. 

Select object 

Select the first line (whose endpoint you selected). 

Select object 

Continue selecting lines until all lines you wish to join have been 
selected. 

Press [RETURN] 

All selected lines are merged into one line. 
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gLINE 

Type Menu Availability 
GLN or GLINE GTX Edit>Draw Line GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:    

gLINE draws a raster line in the current raster image. 

Instructions: 

From point: 

Select or type the first endpoint. 

To point: 

Select or type the other endpoint. 

The command continues, allowing you to continue entering point 
coordinates. 

To point: 

Note: If there is no active image, gACTIVE will be invoked before 
continuing with gLINE. If there is no image attached, gCREATE will 
be invoked to set up an image into which the raster line can be 
drawn. 

Enter the endpoint for the next line or press [RETURN] to end the command. 
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gLINE2 

Type Menu Availability 
GLINE2 GTX Edit>Draw Line2 

 

GTXRaster CAD & 

GTXRaster CAD PLUS 
 

Icon:  
 

GLINE2 draws multiple raster lines in the current raster image. 

Instructions: 

Command: gline2 

Line width <0.010>/Box/Pick: 

From point: 

Select or type the first endpoint. 

To point: 

Select or type the other endpoint. 

From point: 

Select or type the second endpoint. 

To point: 

Select or type the other endpoint. 

 

The command continues, allowing you to continue entering point 
coordinates. 

                          Press [RETURN] to end the command. 
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gMCOPY  

Type Menu Availability 
GMCOPY GTXEdit>Multiple Copy  GTXRaster CAD, 

GTXRaster CAD PLUS 

 

Icon:   

gMcopy  copies selected raster data from a starting base point to one or more 
drawing coordinates (second points) in the current raster image. 

Command: GMCOPY  
 

1. Select raster data to be copied  

 

2. Pick the base point reference 

 

3. Pick the second point that locates the copied position 

 

4. Continue picking of destination points until all copies are complete 
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gMIRROR 

Type Menu Availability 
GMI or GMIRROR GTX Edit>Mirror 

 

GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:    

gMIRROR creates a mirror image 
of selected raster data. This is 
different from reflect which mirrors 
the entire current raster image. 
You will define a line for the data 
to be mirrored across. You may 
either retain or discard the original 
data. 

Instructions: 

1. Select gMIRROR. 

Select raster <WINDOW>: 

2. Select the raster data to be mirrored. The selected raster will be 

highlighted. 

3. When you have selected all the items to be mirrored, press 

[RETURN]. 

First point of mirror line: 

4. Select a point for the start of the reference line. 

Second point: 

5. Select another point to define the reference line. 

Delete old objects? Yes/<No> 

6. Press [RETURN] to preserve the original raster geometry. If you only 

want to keep the new mirrored data, enter Y. 
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gMOVE 

Type Menu Availability 
GM or GMOVE GTX Edit>Move 

 

GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:    

Function: 

gMOVE moves selected raster data from one area to another on the 
drawing. The displacement points define the relative distance and angle 
that the items will be moved from the original position. 

Note: Turn ORTHO mode ON to move objects in perfectly horizontal or 
vertical directions. 

Options:  

Base point Indicate the offset distance for the copy by selecting two 
points. 

Displacement Enter X and Y offset values to indicate copy placement. 

Instructions: 

1. Invoke gMOVE. 

Select raster <WINDOW>: 

2. Select the raster data to be moved. The selected raster will be 

highlighted. 

3. When you have selected all the items to be moved, press 

[RETURN]. 

Base point or displacement: 

There are two ways to respond. You can either select the first of two 
points that will show the movement graphically or type in the offset 
values in the form X,Y. Since the system does not know whether the X,Y 
value typed in is the base point or the displacement distance, the 
response to the second prompt clarifies this. 

Using Base Point 

a. Select a point either by using the cursor or by typing the 
coordinates. This will be a reference point for the moving process. 

Base point or displacement: 
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Second point of displacement: 

b. A rubber-banding line will appear attached at the base point. 
Select a second point to define the relative distance and angle for the 
new placement of the data. The data will appear in the designated 
location in the main raster color. The raster will disappear from the 
original location. The command will be terminated. 

Using Displacement 

a. Type in the X and Y values for the displacement in the same 
format used to enter coordinates. You will see the same prompt as 
above. 

Second point of displacement: 

Press [RETURN] in response to the prompt to indicate that the original 
entry was the displacement. The raster data you selected will disappear 
from the original location and be displayed in the new location in the 
raster color. 
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Move All Images 

Type Menu Availability 
gMAI GTX Imaging>Modify Images>Move All Images GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

Move All Images invokes BricsCAD Move command on all image 
entities. 
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gOFFSET  

Type Menu Availability 
gOFFSET 

GOFF 

GTX Edit>Offset GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gOFFSET creates a copy of a 
selected line, arc, or circle parallel 
or symmetrical to the original. This 
command is similar to the 
BricsCAD OFFSET command. 

Instructions: 

Having prepared an image for 
editing, 

1. Invoke gOFFSET. 

Offset distance or Through <Through>: 

2. Either enter a distance or use the mouse to indicate the distance 

through which copies will be offset. 

Select raster <LINE>: 

3. At this point you enter “C” for circle, “A” for arc, or click two points on 

a raster line. 

Line  

Click two points along the raster line. 

Arc/Circle 

Click three points along the circumference of the arc or circle. 

Offset 

Side to offset? 

4. Click a point to one side of the line, arc or circle. (You can click 

inside or outside a circle).A copy of the original entity will be placed 

at the specified offset distance on the indicated side. 
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gPASTE 

Type Menu Availability 
GP or GPASTE GTX Edit>Paste GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:   

gPASTE inserts a saved raster image at a specified location on the 
graphics screen. You can use this command to insert saved raster onto 
an existing image or onto a blank graphics screen to create a new 
image. The image may be scaled or rotated as it is placed. The default 
values for file format and name will be taken from the GTXRAST.CFG 

file or the current database, but can be overridden. Raster files of any 
acceptable format can be used. 

1: Raster data cut from images is oriented relative to the raster 
file’s coordinate system. When cutting raster data from a rotated image 
entity, the raster is not necessarily saved as displayed within BricsCAD. 
Also, when pasting raster data into a rotated image, the raster data 
appears at the image entity’s native rotation. 

2: If there is no active image, gACTIVE will be invoked before 
continuing with gPASTE. If there is no image attached, gCREATE will be 
invoked to set up an image into which raster data can be pasted. 

Options:  

Source Options: 

File Insert raster data from a raster file. 

Buffer Insert raster data from a temporary buffer (previously created 
with gCUT). 

Paste Options: 

Move Move the pasted data to a different location. 

Rotate Specify the desired orientation (angle) of the image. 

Scale Specify the factors by which to change the X and Y dimensions. 

Fit A “Scale” option that allows you to show the scale graphically. 

Instructions: 
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1. Invoke the gPASTE command. 

File/<Buffer>: 

2. Type F to paste data from a raster file. Type B, Buffer or [RETURN] 

if it is the default as shown above to paste data from a temporary 

buffer (created with gCUT). 

Pasting from a File:  

gPASTE will determine the 

raster file you wish to paste. If 

CMDDIA is set to 1, the 

following dialog will appear: 

Enter the desired file name and 
select the appropriate path for the 
new file.  

If CMDDIA is set to 0, 

gPASTE will issue the following prompt: 

Command: GPASTE 

Enter raster file name <cut_data.ext>: 

Type the name of the raster file that you want to paste. “Cut_data” or 

the last file pasted is the default, shown in brackets. If no path is 

entered, the program looks for the file in the current directory, then 

for the ACAD path, then for the DOS path. 

Pasting from a Buffer 

gPASTE will paste raster data from a buffer only if you previously 

performed a gCUT to that buffer. 

After determining the source of the raster data to be pasted, the following 
prompt will appear: 

Insertion point <0.0000,0.0000>: 

3. Select the point where the lower left corner of the file should be 

placed. The raster data of the file will appear at that location in the 

main raster color. The gPASTE menu will replace the GTXRAST 

menu. 

Loading raster -- filename.ext ... 
Move/Rotate/Scale  

4. If you are satisfied with the default settings and the present location 

of the raster, press [RETURN] to exit from the command. To change 

the location, rotation or scale, select the desired option. Options can 

be selected in any order and any number of times until you press 
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[RETURN] to exit from the command. 

The same data can be selected for further raster editing with the 
“previous” option of the editing command. For instance, if you want to 
have more than one copy of the pasted data at the same size and 
orientation, you can select gCOPY and “previous”. 

Using Move 

1. Select “Move” by entering “m” or selecting “Move” from the 
menu. The pasted data will be highlighted. You will be prompted to 
indicate a base point for the move. 

Base point or displacement: 

2. Select a reference point. This may be a significant point such as the 

center of a cross. 

Second point of displacement: 

A rubber-band line will extend from the base point. 

3. Select a second point to indicate the distance and angle that the 

base point should move. The raster data will move to the new 

location and be un-highlighted. The reference line disappears. 

Move/Rotate/Scale: 

4. You can continue to select options or press [RETURN] to terminate 

the command. 

Using Rotate 

1. Enter “r” or select “Rotate” from the menu to change the 
orientation of the reference box. The pasted data will be highlighted. 

Base point: 

2. Select a point for the center of rotation. 

Rotation Angle <0.0>/Reference: 

3. A rubber-band line will extend from the base point. The rotation point 

is the lower left corner of the box. The rotation is counter-clockwise 

from the X-axis if a positive angle is entered. 

There are several ways to respond. You can accept the default angle by 
pressing [RETURN] or use either of the two options. The default angle, 
initially zero degrees, reflects the value used for a previous gPASTE 
operation. 
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Rotation Angle 

Using rotation angle, you can specify the angle with reference to the 

X-axis by typing in a value (in degrees) or by rubber-banding the 

reference line. 

When you designate the angle by either method, the raster will be 

redrawn in the new orientation. 

Using Reference Angle 

Using reference angle, you must enter “r” or select “Reference” from 

the menu. You then indicate a different base line (not the X-axis) for 

the graphic angle. 

Reference angle <0.0>: 

 You can either enter a degree value to define the new base line in 

relation to the X-axis or you can define it graphically by selecting the 

first point for the base line. 
Reference angle <0.0>: Second point: 

 Select the second point for the base line. 
New angle: 

 Indicate the final position for the new base line by entering a value. 

You can also indicate the rotation angle graphically if you chose the 

original base point (the center of rotation) as the first point of the new 

base line. The selected data will rotate the same amount. The angle 

of rotation will actually be the angle between the reference line 

positions. 

For example, if the desired rotation would bring a certain line to a 

vertical position, you could draw the base line over that line and then 

type “90” for the new angle. The default angle then will be 90 minus 

the angle of the base line. 

 As soon as the rotation angle has been specified, the highlighted 

data will rotate about the base point. The highlighting will be 

removed. 
Move/Rotate/Scale 

You can select another option to change or press [RETURN] to 

terminate the command. 

Using Scale 

1. If you enter “s” or select “Scale” from the menu, the pasted data 
will be highlighted and you can change the size of the image. The default 
value is initially set to X=1, Y=1. 
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Base point: 

2. Select the point about which the raster will be scaled. This point will 

not change its location. It also serves as the first point for the scale 

rectangle if you use the graphic method of scaling. 

Scale factors <1.0,1.0>/Fit: 

3. The data is scaled from the base point. You can type the numerical 

values by which to scale the X- and Y- dimensions or select “Fit” and 

change the height and width graphically. 

If you select “Fit”, you will be prompted to select the original size. 

Select original size: 

Select two corners of a box representing the size of the original 

image. 

Select new size: 

Draw the window to show the relative size of the desired image to 

the reference box. The data that filled the original rectangle will be 

enlarged or compressed to fit into the new rectangle. The X and Y 

dimensions can be different. 

After you indicate the scale by either method, the pasted data is redrawn 
at the new size and un-highlighted. 

Move/Rotate/Scale: 

4. You can select another option to change or press [RETURN] to 

terminate the command. You can further adjust the image after you 

have placed it with the “previous” option in the desired command 

(gMOVE, gSCALE, etc.).
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gPDFATTACH  

Type Menu Availability 
GPDFATTACH GTXImaging>PDF Attach  GTXRaster CAD 

GTXRaster CAD PLUS 

 

Icon:   

Function: Extract and Attach an Image from a PDF File 

Opens Windows Explorer for selection of a PDF file that contains a 

drawing image.  
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gPDFSAVE  

Type Menu Availability 
GPDFSAVE GTXImaging>PDF Save GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:   

Function: Save an Attached Image to a PDF File 

Save an image to a PDF file from the current BricsCAD drawing session. If more that 

one image is currently attached to the drawing session then the GTX Image 

Selection control will appear for selection of which image file is to be saved. 
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gRAHEAD 

Type Menu Availability 
GRAH or GRAHEAD GTX VClean>Remove Arrow Heads GTXRaster R2V 

GTXRaster CAD PLUS 

Icon:   

Function: gRAHEAD erases “arrowheads”  (three-sided solids). 

Instructions: 

Filter Arrow heads - All/<Select objects>: 

Type A for all or press [RETURN] to select a group of objects 

If you typed A, then all 3-sided solids are erased.  If you chose to select 
objects, the following prompt is shown: 

Select objects: 

Window or pick objects.  Press [RETURN] when done.  arrowheads are 
highlighted. 

Press [RETURN] to erase them. 
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gRASTER 

Type Menu Availability 
GRA or GRASTER GTX Convert>Rasterize GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gRASTER converts selected vector entities into raster data with a 
designated line width. The BricsCAD line style will be preserved. 

Options:  

Width Options 

Table Use the width settings 
according to color as set in the 
Width Table 

Box Define a value graphically to be used for the width of the vector 
selected to be converted to raster. 

Value Type in a value in inches or millimeters to use for the width of the 
vector selected to be converted to raster. 

Note: 
1. If there is no active image, gACTIVE 

will be invoked before continuing 
with gRASTER. If there is no image 
attached, gCREATE will be invoked 
to set up an image into which raster 
data can be created. 

2. Only entities within the raster limits 
can be rasterized. Those selected 
outside the limits will be ignored or 
erased. When entities are partially 
outside, the part inside is rasterized; 
the part outside is erased. 
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Instructions:  

Dialog 

1. Invoke gRASTER. The following prompt will appear: 

Select objects: 

2. Select the vector entities to be converted. 

When all entities to be converted are 

highlighted, press [RETURN]. The 

Rasterize Setup dialog will appear.  

3. To specify line width, you can enter a 
Fixed line width, specify it graphically by 
drawing a Box or use a Table of vector color-
to-raster line width correlations. 

Fixed Line Width: 

Select the Fixed radio button. Type a value (in mm or inch) as the 

width to be used for all the vector lines to be rasterized, or use the 

value in the Fixed Width text field. If you enter a value it will remain 

the default line width during this editing session. 

Note: If you defined the width previously in this session with a typed 
value or the “box” option, that value will appear as the default. 

Using the LineWidth Configuration Table: 

a. Select the Table radio button and the Table Setup button. The 
LineWidth Configuration Table appears, correlating BricsCAD color 
numbers and line widths expressed in current units. 

b. To change the width associated 
with a particular BricsCAD color, select 
that ACAD Color row. Enter the value in 
the Width text field. Select OK to close 
the dialog or select another row to change 
its width. 

Enter width <.XX>: 

c. Enter the value for the width in 
the units being used and press 
[RETURN]. The Width Table will reflect 
the changes. 
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d. Select another color number to change its width or press [0] and 
[RETURN] to continue the command. 

The entities will be changed to raster with the widths defined by their 
colors. 

Using Box 

a. Select Box. 

Select first corner of box: 

b. Select a point. 

Select opposite corner of box: 

c. As you move the cursor, a rubber-banding rectangle appears 
with one corner at the point selected. Move the cursor until the box is the 
desired width and the length exceeds the width. Select the point. 

The best way to use this feature is to pick a point on the edge of an 
existing horizontal or vertical raster line and stretch the box along the 
line. You can then easily match the width. The length of the rectangle 
can be any size that is longer than the width as the smallest side is used 
as the width measurement. A reference rectangle is used instead of a 
square to make it easier to see. As soon as the second point has been 
selected, the rasterization takes place. 

Note: The next time you use this command, the value of the width you 
used will be displayed as the default fixed linewidth. 

The highlighted entities will be converted to raster. Some residual vector 
markings overlay the raster until you redraw the image. 

Using Pick 

a. Select a vector entity  

b. Select the Pick option 

Select raster <width>: 

c. Next select a raster entity or enter a width  

A dialog box will appear with a fixed width value of the raster entity 
selected. 

d. Select OK 

The vector entity selected will be converted to line width of the previous 
raster that was selected using the Pick command. 
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BricsCAD Prompts 

1. Select gRASTER.  

Select objects: 

2. Select the vector entities to be converted. When all entities to be 

converted are highlighted, press [RETURN]. 

Raster width Box/<Table>/.01: 

3. There are three ways to respond to this prompt. You can 1) type in a 

value as the width to be used for all vector lines to be rasterized for 

plotting; 2) use the LineWidth Configuration Table to correlate 

BricsCAD color numbers with line widths; or  3) use the Box option to 

specify a standard linewidth graphically. 

Fixed Line Width: 

a. You can type in a value (in mm or inch) as the width to be used 
for all the vector lines to be rasterized. The value in parentheses is the 
default value or one previously used. If you enter a value it will remain 
the default line width during this editing session. 

Note: If you defined the width earlier in the session, that value will 
appear as the default. You can press [RETURN] to accept this 
value or enter a number to represent the new width. The selected 
entities will all be converted to raster with the designated width. 

Using the LineWidth Configuration Table: 

a. If you type in “T” or “Table”, the LineWidth Configuration Table 
appears. The listing correlates BricsCAD color numbers and line widths 
expressed in current units. 

b. If you defined the width previously in this session with a typed 
value or the “box” option, that value will appear as the default. You can 
press [RETURN] to accept this value or enter a number to represent the 
new width. The selected entities will all be converted to raster of the 
designated width. 

Note: The original default option is to use 
the Width Table set up by colors. 
This allows you to set different 
widths for entities being rasterized 
according to their color. If you press 
[RETURN] or [T], the Width Table will 
be displayed. The widths will be in 
inches or millimeters according to 
the unit set in GTXRAST.CFG. 
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c. Enter the number and press [RETURN] 

Enter width <.XX>: 

d. Enter the value for the width in the units being used and press 
[RETURN]. The Width Table will reflect the changes. 

e. Select another color number to change its width or press [0] and 
[RETURN] to continue the command. 

Note: The width settings you change will remain in effect until you 
change them or you exit BricsCAD. 

The entities will be changed to raster with the widths defined by their 
colors. 

Using Box 

a. At the prompt, type “B” or select “Box” from the menu. 

Select first corner of box: 

b. Select a point. 

Select opposite corner of box: 

c. As you move the cursor, a rubber-banding rectangle appears 
with one corner at the point selected. Move the cursor until the box is the 
desired width and the length exceeds the width. Select the point. 

The best way to use this feature is to pick a point on the edge of an 
existing horizontal or vertical raster line and stretch the box along the 
line. You can then easily match the width. The length of the rectangle 
can be any size that is longer than the width as the smallest side is used 
as the width measurement. A reference rectangle is used instead of a 
square to make it easier to see. As soon as the second point has been 
selected, the rasterization takes place. 

The highlighted entities will be converted to raster. Some residual vector 

markings overlay the raster until you redraw the image. 

Note: 
1. The next time you use gRASTER, the value of the width you used will 

be the default fixed line width. 
2. If the width value is less than 1 pixel, the raster width will automatically 

be reset to 1 pixel, regardless of the way the width was set. 
3. Polylines and other non-filled entities that have a width attribute will be 

drawn with the BricsCAD width attribute. 
4. Rasterization of certain entities may take a while to process. 

Rasterizing text and ellipses takes longer than lines, for instance. 
Select less data at a time to improve rasterization speeds. 

5. gRASTER does not convert 3-D entities 
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CALS Plotter Driver 

An alternative method for rasterizing vector data is to use the Raster File 
Format HDI plotter driver.  This can be configured using the Autodesk 
Plotter Manager from the Windows Control Panel. 
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gRECTANGLE 

Type Menu Availability 
GRECT, GRECTAN or 

GRECTANGLE 

GTX Edit>Draw Rectangle 

 

GTXRaster CAD & 

GTXRaster CAD PLUS 
 

Icon:  
 
 
gRectangle draws a raster rectangle in the current raster image. 
 
Instructions: 
 
Command: grectangle 
 
Line width <0.010>/Box/Pick: 
 
1.Select first corner of window:   

 
           Select or type the first corner point. 
 

            2.Select opposite corner of window:  

 

                                                   Select or type the second corner   point. 
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gREFLCT 

Type Menu Availability 
GREF or gREFLCT GTX Enhance>Reflect GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

gREFLCT reflects the raster within an image about the X or Y axis. This 
command can be useful if an image was scanned through the back of 
transparent media. 

Instructions:  

1. Select gREFLCT. 

Select axis to mirror data about <Xaxis>/Yaxis: 

2. Select “X” or “Y” or press [RETURN] to select the default value. The 

entire image is flipped about the chosen axis and the raster limits are 

rotated to the new orientation. 
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gRELIMIT 

Type Menu Availability 
GREL or GRELIMIT GTX VClean>Relimit GTXRaster CAD PLUS 

Icon:   

gRELIMIT combines the effects of BricsCAD TRIM and EXTEND 
commands for vector lines 

Instructions:  

Select line end point: 

1. BricsCAD’s End AutoSnap becomes enabled to help select 

endpoints.  Select the end of the line you want to trim or extend.  

Select Object: 

2. Select the boundary line. 

The line will lengthen or shorten to meet the boundary. 

If the line cannot shorten or lengthen to meet the boundary, the following 
message is displayed: 

Object does not intersect an edge. 
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gRESIZE 

Type Menu Availability 
GRE or GRESIZE GTX Enhance>Resize GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gRESIZE changes the size of the raster work area. You can increase the 
dimensions in both positive and negative directions. This is useful to 
accommodate pasting in additional raster files, scaling up the drawing, or 
making edits that would move data beyond the existing limits. You can 
also reduce the work area to reduce memory requirements; for instance, 
when the actual data you need occupies only a small portion of the work 
area. 

Instructions: 

1. Select gRESIZE. 

This command could fail in limited memory situations 

Do you want to save the raster image first? Yes/<No>: 

2. If you have not recently saved your data, respond “Yes”. You will be 

prompted for a file name and then returned to the command. 

Select lower left corner of raster limits <X.XXX,X.XXX>: 

3. Select a point with the mouse or type in the coordinates for the point 

to be the lower left corner of the work area. Negative numbers are 

acceptable. 

Select upper right corner of raster limits: 

4. Select a point with the mouse or type in the coordinates for the point 

to be the upper right corner of the work area. Make sure that all the 

existing raster data is enclosed in the resulting window. Any raster 

data not included will be eliminated from the database. 

Lines marking the raster work area move to the new boundaries. Existing 
data retains the same coordinates as before. 

Warning:  When resizing an image, consider the drawing’s scale. Raster 
images will normally be about the same size as paper media. 
Ensure your image remains within a normal “paper” size and 
then scale it against your vector data. You don’t want to create 
a raster image the size of a house or a map - it will take a long 
time if it works at all! 

 



 

 141 

 

gROTATE  

Type Menu Availability 
GR or GROTATE GTX Edit>Rotate GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gROTATE rotates selected raster data. You will define the center point 
and a rotation angle to specify the new orientation for the data. The 
rotation angle may be selected by entering a value or by picking two 
points to indicate the angle graphically. gROTATE can also be used to 
“deskew” a specified section of a drawing. 

Options: 

Rotation Angle Specify the rotation angle with respect to the X axis. 

Reference Angle Draw a new base line and indicate the desired 
angle for this line. 

Instructions: 

1. Select gROTATE. 

Select raster <WINDOW>: 

2. Select the raster data to be rotated. When everything you want to be 

rotated is highlighted, press [RETURN] to continue the command. 

Base point: 

3. Select a point on the entity to be used as the center point for the 

rotation process. The entity will turn about this “anchor” point as it 

rotates. It will also be used as the base point for a graphic 

representation of the rotation angle. 

Rotation angle <0.0>/Reference: 

4. There are several ways to respond to this prompt. You can enter the 

default value, a new rotation angle, or use reference angles to 

graphically designate the rotation. 

Using the Default Angle 

a. The default angle, initially zero degrees, reflects the value used 
for a previous gROTATE operation. You can accept the default angle by 
pressing [RETURN].  
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Delete old objects Yes/<No>: 

Using Rotation Angle 

a. You can specify the angle with reference to the X axis by typing 
in a value (in degrees) or by rubber banding the reference line. 

b. When you designate the angle by either method, the raster will 
be redrawn in the new orientation. 

Using Reference Angle 

a. Enter “R” or select “Reference” from the menu to use a different 
base line (not the X axis) for the graphic angle. 

Reference angle <0.0>: 

b. You can either enter a degree value to define the new base line 
or define it graphically by selecting a point. If you select a point, you will 
be prompted for the second point. 

Reference angle <0.0>: Second point: 

Select the second point to define the line that should be rotated to a 
particular angle. 

New angle: 

c. Type in the value for the angle the new base line should take. 
The selected data will rotate the same amount. The angle of rotation will 
actually be the angle between the reference line positions. For example, 
if the rotation should bring a certain line to a vertical position, you could 
draw the base line over that line and then type “90” for the new angle. 
The default angle will then be 90 minus the angle of the base line. 

 

 

 

 

 

 

 

 



 

 143 

 

5. Respond “yes” if you do not want to retain the original data in 

addition to the rotated copy. 

 
Note:  
1. If raster data is placed so that it is outside of the set raster drawing 

limits, the portion outside the drawing limits will be lost. If this 
happens, use UNDO, use gRESIZE to extend the raster limits as 
necessary, then use gROTATE to rotate the data. Nothing will be lost 
because all raster is within the new raster limits. 

2. Rotating raster data may distort it somewhat. The “line”, “arc”, and 
“circle” intelligent raster object picking methods may not work on 
raster data that has been rotated several times. 

3. gROTATE can rotate raster right off the image. To rotate an entire raster 
image 90 degrees, rotate the image entity using the ROTATE command, 
or use gTURN so that the image is automatically resized. 

4. Positive values rotate raster in a counter-clockwise direction. 

As soon as the rotation angle has been defined by whatever method is 

used, the highlighted data will rotate as specified about the base 

point. The command terminates. 
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gROTRECTANGLE 

Type Menu Availability 
GROTRECTANGLE GTX Edit>Draw Rotated 

Rectangle 

GTXRaster CAD 

GTXRaster CAD PLUS 

 

 Icon:  

Draw a raster rectangle at any rotated orientation in the current raster 
image by defining the rectangle's baseline and height. 

  Instructions: 

Command: grotrectangle 

Line width <0.010>/Box/Pick: 

1.Enter a line width for the raster lines of the rectangle  

2.Select insert point of baseline:   

            Select or type the first corner point of the baseline. 

3.Select end point of baseline   

            Select or type the second corner point of the baseline.. 

4.Select rectangle height 

            The raster rectangle is drawn when the height point is selected. 

 

 

 

 

 

 

 

gROTRECTANGLE 
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Rotate All Images 

Type Menu Availability 
gRAI GTX Imaging>Modify Images>Rotate All Images GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

Rotate All Images invokes BricsCAD Rotate command on all image 
entities. 
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gRUB 

Type Menu Availability 
GRU or GRUB GTX Edit>Rub GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gRUB erases raster data after it has been converted or traced to vector 
entities. You select the vector entities overlying the raster that is to be 
erased. This lets you use the raster to evaluate the conversion and then 
erase it easily. 

Instructions:  

1. Select gRUB. 

Select objects: 

2. Select the vector entities over the raster to be erased. When all the 

desired entities are highlighted, press [RETURN]. You will see a 

message indicating the percent of rub completed. 

Note: The width at which gRUB erases is determined by the linewidth 
configuration table. Automatically generated polylines have no 
actual width, so they are not very effective for erasing underlying 
raster. gERASE can be more effective in this situation. 
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gSAVE  

Type Menu Availability 
GSA or GSAVE GTX Imaging>Save GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gSAVE saves changes made to a raster image.  

A filename can be up to 256 characters long. If the extension is not 
included, the default raster format and its extension (such as “.RNL”, 
“.RLC”, or “.CG4”) will be used. 

TIFF subformats (uncompressed, Version 6 tiled, etc.) default to the 
TIFFFORMAT setting in GTXRAST.CFG. 

Instructions:  

1. Invoke gSAVE. The SAVE Raster 
File dialog appears:  

2. Select the output format from the 
List Files of Type box. Enter the File 
Name and press OK. 

3. If the file name already exists, you 

will be prompted to overwrite the file 

or cancel the save. 

The drawing is saved. 

Renaming an Image 

If you saved the image to a new name, note that the image entity still 
points to the originally attached raster file. If you want the drawing to 
point to the new filename you must do the following: 

1. Select Insert>Raster Image... to invoke the BricsCAD IMAGE 

command. 

2. Select the GTXARCH image. Above under the Saved Path column 

you can see the original raster filename. At the bottom of the dialog 

you can see an “Image Found At” text box, which points at the 
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recently saved filename. 

3. Select Save Path. This tells BricsCAD that you want the changed 

filename as the one to which the image points. 

Note: 
1. The lower left corner of the drawing raster limits is set as the insertion 

point to be used when the file is loaded or pasted. 
2. Always save when leaving for any length of time and before loading 

new files. If performing many tasks on a single drawing, it is a good 
idea to save the files periodically. 

3. Select OK. 

Saving Color Images  

There is a difference in the way the gSAVE operates depending upon if 
you are saving a color or black & white (binary) image. Color images 
have a more restricted number of file saving formats. 

Supported Color file formats. 

When working with color images in GTX you can only save in  

.tif (uncompressed TIFF),  

.bmp (Uncompressed Bitmap),  

.png (Portable Network Graphics),  

.tga (Taga), &  

.pcx (PC Paintbrush) formats.  

Also, if you originally loaded a .jpg (JFIF JPEG) file you will 
additionally be offered the option of saving in .jpg (JPEG) format.  
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gSCALE 

Type Menu Availability 
GS or GSCALE GTX Edit>Scale GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gSCALE changes the size of raster geometry within an image entity. You 
may scale the data about a reference point by entering X axis and Y axis 
scaling factors or you may scale the raster data graphically. 

Instructions: 

1. Select gSCALE. 

Select raster <WINDOW>: 

2. Select the raster data to be scaled. When all of the data to be scaled 

is highlighted, press [RETURN]. 

Base point:  

3. Select a point near the data selected. This point is the reference 

point to scale the entities about (it will not change its location). It also 

serves as the first point for the scale rectangle if you use the graphic 

method of scaling. 

Scale factors<1.0,1.0>/Fit: 

The value in the brackets is the default value, either the initial default of 
1.0,1.0 (scale by 1 in both X and Y directions) or any values previously 
used with the gSCALE command. 

4. There are several ways to respond to the prompt. You can use the 

default value or enter the numerical scaling factors for X and Y. You 

can also indicate the size graphically be selecting “Fit”. 

Using the Default Scaling Factors 

Scale factors<1.0,1.0>/Fit: 

a. The default scaling values reflect the scale factors used for a 
previous gSCALE operation or 1.0,1.0 if the command has not been 
used. You can accept the default scale factors by pressing [RETURN]. 

Entering Numerical Scaling Factors 

Scale factors<1.0,1.0>/Fit: 
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a. Enter two values separated by a comma to indicate the X and Y 
scale factors respectively. To enlarge the image, enter scale factors 
greater than 1. To shrink the image, enter scale factors between 0 and 1 
(Entering “2,2” doubles each dimension and increases the area by a 
factor of 4. Entering “.5,.5” cuts each dimension in half and decreases 
the image to 1/4 its original size.) 

Using “Fit” 

Scale factors<1.0,1.0>/Fit: 

a. After selecting the base point, select “Fit” from the menu or enter 
“F”. A rubber-banding box anchored at the base point will appear. 

Select original size: 

b. Rubber-band a reference rectangle from the base point 
representing the original size of the raster data being scaled. 

Select new size: 

c. Rubber-band a new reference rectangle from the base point 
representing the new size of the raster data. The “Fit” option generates 
scale factors based on the size ratio between the reference rectangles.  

Note: 
1. gSCALE can scale raster data right outside the image entity, and the 

data is lost! To avoid this, choose the base point to avoid rotating the 
data outside the limits of the image.  

2. After scaling, you can easily re-select the rotated data and reposition it 
with gMOVE “previous” if necessary - this even works if the rotated 
data overlaps with preexisting raster. 

3. To expand the image, save the file and then use gRESIZE to enlarge the 

raster work area. 
4. Scaling a raster image with different X and Y factors will cause raster 

arcs and circles to become elliptical. The resulting shapes cannot be 
selected using the intelligent raster object “arc” and “circle” picking 
methods. 

5. The data is scaled to the dimensions indicated by the scaling factors. 

The command is terminated. 
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Scale All Images 

Type Menu Availability 
gSAI GTX Imaging>Modify Images>Scale All Images GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:  

Scale All Images invokes BricsCAD Scale command on all image 
entities. 
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gSETLAY  

Type Menu Availability 
GSETLAY 

GSL 

GTX VClean>Set Layer GTXRaster CAD PLUS 

Icon:   

gSETLAY sets the current layer to that of a specified entity 

Instructions: 

Dialog/<Select object>: 

1. Select an object whose layer you wish to make current or type D to 

use the dialog. 

Select Object:  

The selected object’s layer becomes 
current. 

The following dialog appears: 

Select the layer you wish to make current 
and press OK or select New Layer. 

Pressing OK makes the selected layer 
current. 

Selecting New starts the New Layer Creation dialog: 
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gSLICE 

Type Menu Availability 
GSLICE GTX Edit>Slice 

 

GTXRaster CAD & 

GTXRaster CAD PLUS 
 

Icon:  
 
GSLICE separates raster objects that should not be joined. 
A two pixel wide gap is created along a pick line selected by  
a starting point and an ending point. 
 
Instructions: 
 
1.From Point:   

    
          Select or type the first endpoint 
 
2.To Point:       

          
          Select or type the other endpoint 
 
3.From Point:   

  
          Select or type the first endpoint 
 
4.To Point:       

 
          Select or type the other endpoint 
 
 
The gSlice command continues prompting for the starting point of the 
next slice until you select [RETURN]. 
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gSMOOTH  

Type Menu Availability 
GSM or gSMOOTH GTX Enhance>Smooth GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:   

gSMOOTH smoothes raster objects in a selected portion of the raster 
data. gSMOOTH can also make raster lines orthogonal or parallel to a 
specified angle, combine fragmented raster lines. gSMOOTH can 
smooth raster linewidth to a fixed value or snap raster linewidth to a 
series of user-defined linewidths. By smoothing raster, gSMOOTH can 
reduce the file size by up to 30 percent. 

Instructions:   

Dialog:  

Conversion Type indicates the type of 
raster-to-vector conversion being used 
to smooth the raster.  CAD interprets 
raster as lines, arcs and circles.  
Contour interprets raster as polyline 
contours. 

Ortho improves the drawing by 
snapping lines to horizontal or vertical. 

None smoothes the data exactly as it 
appears without any rectification. 

Reference snaps lines close to any reference angle to that angle and 
parallel lines at this angle separated by a distance close to the offset 
distance will snap to the offset distance.  

Line Width Options 

Box defines a value graphically to be used for the width of the data 
selected to be smoothed. 
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Value applies a literal value to use for the width of the selected data to 
be smoothed. 

Note: Be sure to enter values in current units (mm or inches), not in the 
current BricsCAD Drawing Unit. The graphically defined width will 
also be translated to mm or inches when it appears as the default. 

Average smoothes raster geometry to an average of that segment’s 
width. 

Table snaps the lines to the nearest value listed in the Width Table. 

BricsCAD Prompts 

1. Select gSMOOTH. 

Select raster <WINDOW>: 

2. Select the raster to be smoothed. When all the data to be converted 

is highlighted, press [RETURN]. 

Width Box/Table/<Average>/0.01: 

3. There are several ways to respond to the prompt. You can enter a 

value to be the fixed line width for all selected data or you can select 

this value graphically with the “Box” option. You can average each 

raster element’s width or you can set up a Table of LineWidths to 

which raster elements are snapped. 

Using a Fixed Line Width 

a. The value shown in the prompt is the value used last or the one 
set for RasterWidth in the configuration file. To accept the default value, 
press [RETURN]. Type a number that represents the width in current 
size units. 

Using Box 

a. At the prompt, type “B” or select “Box” from the menu. 

Select first corner of box: 

b. Select a point on the edge of a horizontal or vertical raster line. 

Select opposite corner of box: 

c. As you move the cursor, a rubber-banding rectangle appears 
with one corner at the point selected. Stretch the box along the line and 
match the width. The length of the rectangle can be any size that is 
longer than the width as the smallest side is used as the width 
measurement. Select the second point. 
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Using The Average Width 

a. At the prompt for width, type “A” or select Average from the 
menu. Each element will be smoothed to its average width. If parts of a 
line are significantly different in width, they will be averaged separately. 

Using The LineWidth Table 

At the prompt for width, type “T” or 
select Table from the menu. The 
LineWidth Table will be displayed. The 
widths will be displayed in the units 
set in GTXRAST.CFG. This allows 
you to set up to seven different widths 
to which the lines snap. 

Note: The colors do not affect raster smoothing. In this command they 
only determine the title under which a line width is defined. 

c. Enter the value for the width in the size units being used (inches 
or millimeters) and press [RETURN]. The Width Table will reflect the new 
value. 

d. Select another color number to change its width or type “0” and 
[RETURN] to continue the command. You can set up to seven different 
widths. 

Rectify <Ortho>/None/Reference: 

4. There are several ways to respond to the prompt. The default is 

orthogonal rectification. You can create reference angles to snap 

lines to a particular non-orthogonal angle (such as hatching) or you 

can use no rectification. 

Using Orthogonal Rectification 

a. If “Ortho” is the default mode, just press [RETURN] to accept the 
default of orthogonal rectification. Otherwise, type “O” and [RETURN]. 
All lines within a few degrees of 0 and 90 degrees will be rectified to 0 
and 90 degrees. 

Using Reference Angle(s) 

a. Type “R” or select Reference from the menu. The option will 
prompt you to draw a line showing the reference angle to which lines will 
be snapped. 

First point for snap angle: 
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b. Select the first point to define the angular line. 

Second point for snap angle: 

c. Select the second point to define the angle. 

Parallel alignment offset <0.0>: 

d. This value determines the distance between the imaginary grid 
lines parallel to the given reference angle. Type in a value in current 
drawing units. Using the (0.0) value which is always the default means 
no grid snapping for this angle. 

First point for snap angle: 

e. You can define another reference angle and grid or press 
[RETURN] if you don’t want to use another one. When you are finished 
defining the angles, press [RETURN]. 

5. After you respond to the last prompt, the conversion will take place 

and you will see the message “Processing Image...” 
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gSPECKL 

Type Menu Availability 
GSP or GSPECKL GTX Enhance>Speckle GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gSPECKL filters and removes speckles from the raster image.  
gSPECKL can also fill in small holes in solid raster. 

Options:  

Pick Options 

gSPECKL allows only Window, PWindow or View raster picking to and to 
add or remove raster data to/from the selection set. 

Mode Options  

Delete Remove speckles from the raster. 

Fill Fill in small holes in the raster. 

Instructions: 

1. Select gSPECKL. 

Speckle size <0.00>/Box/Pick: 

2. There are two ways to respond to this prompt. You can enter a value 

or you can use the “Box” option to graphically specify the speckle 

size. 

Entering a Value 

a. Specify an absolute value and hit [RETURN]. This value will 
represent one side of a square area. The speckles or holes to be 
affected must be within this tolerance. 

Using a Box 

a. To use the graphics method, type “B” or select Box from the 
menu. 

Using Pick 
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a. Single-click with the left mouse button on a sample speckle in 
the image.  Raster data of that size and smaller will be considered to be 
speckles. 

Select first corner of box: 

b. You may want to window an actual speckle or hole to gauge the 
proper size. Select a point for one corner of the window or box. A rubber-
banding box will appear with one corner attached at the point. 

Select opposite corner of box: 

c. Drag the box to the desired size and select the second point. 
The largest side of the box will be used as the reference dimension to 
define maximum speckle/hole size. 

3. After specifying the speckle size, the following prompt will appear: 

<Delete Speckle>/Fill hole: 

4. This sets the mode of the gSPECKL command. Select the desired 

mode from the menu or type its abbreviation. Type “D” and 

[RETURN] for “Delete” or type “F” and [RETURN] for “Fill”. 

Select raster <WINDOW>: 

5. Select the area of the drawing to be processed with the “Window”, 

“PWindow” or “View” option. All of the speckles or holes of the 

designated size or smaller in the window will be highlighted. 

CAUTION: 
1. Set the speckle size smaller than punctuation marks such as the period 

(.) and colon (:). If your speckle size is larger than these, they will be 
erased and valuable information could be lost! 

2. With large drawings, memory demands can be great for this command. 
If you have problems, despeckle portions of the drawing, saving in 
between (gSAVE). 

3. In the “Select” mode, the “window” option only adds speckles that are 
entirely inside the window and “PWindow” selects speckles that are 
entirely or partially inside the area. In the “Remove” mode, either 
window option removes data up to the window boundary. 

6. Continue to create a selection set using “Add” and “Remove” to 

define the area to process. When you are satisfied with the area 

selections, press [RETURN]. The highlighted speckles or holes in 

the display will be processed. 

 

 

 

 



 

 161 

gTCONFIG 

Type Menu Availability 
GTCFG or GTCONFIG GTX Convert>Text Config GTXRaster CAD PLUS 

Icon:   

gTCONFIG sets up parameters for text IOP and the text conversion 
commands, gTCONVRT and gTRAIN. 

Instructions: 

Text Configuration dialog has four panes: Raster Input, Character 
Recognition, Word Recognition, and Text Output.  This is the order in 
which GTX Intelligent Character Recognition (ICR) functions: 

1. ICR analyzes the selected raster text, filters out raster that is too 

large or small to be text, and gathers string formation information to 

assist in the detection of space characters. 

2. If a piece of raster appears to be two or more touching characters, 

that raster is broken down into its component characters. Raster text 

is compared to samples recorded in character recognition (.ICR) 

files.  A guess is made as to each character’s identity.  Each 

guessed character is assigned a confidence level.   

If only character recognition is being performed, characters with a 

confidence above the Auto-Convert Threshold are automatically 

converted into text.  Characters with a confidence below that 

threshold are presented in the Character Verification dialog.   

3. When Word Recognition is performed, the Auto-Convert Threshold is 

not used.  Instead, characters are formed into strings which are then 

compared to words and patterns in the dictionary files (.DCT).  These 

files contain words and patterns that are likely to appear in converted 

drawings. 

If a recognized word is close to one found in the dictionary, but a 

character is missing or perhaps incorrectly recognized, that character 

can be changed so the word matches the one found in the dictionary.  

One threshold, Force Fit, controls how close a word has to be to a 

dictionary term for it to be changed. Another threshold, Verify, 

determines how likely the user will be interrupted 
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4. When using character recognition (not word recognition), ambiguous 

characters are shown to the user so that 0 and O, 1 and I, 5 and S, 

and other pairs of ambiguous characters appear correctly in the 

BricsCAD text.  Regardless of the conversion method, ICR 

generates BricsCAD text at user-

specified size, using the font of 

the current text style.  

Raster Input  

The Raster Input pane contains 
parameters that control the 
interpretation of incoming raster text 
characters and space recognition. 

IOP 

Sets the minimum and maximum size raster text “blobs” that textwin or 
textline IOP methods are allowed to select. Text IOP separates raster 
text from touching raster geometry (i.e., text with a touching or 
intersecting raster underline). Text IOP needs to know the typical size of 
text characters so it can tell them apart from their surroundings. It also 
selects the minimum and maximum size raster that gTCONVRT will 
attempt to recognize as text. Entities larger or smaller than these values 
will not be selected by text IOP or will be ignored by text conversion if 
another selection method was used.  

Min Char Size 

Sets the smallest size of raster that text IOP will select or that 
gTCONVRT will attempt to recognize. The default value is set by the 
CharMinSize parameter in GTXRAST.CFG. 

Max Char Size  

Sets the largest size or raster that text IOP will select or that gTCONVRT 
will attempt to recognize. The default value is set by the CharMaxSize 
parameter in GTXRAST.CFG. 

Note: Set the Min Char Size between the sizes of speckles and of typical 
period/full stop raster characters (“.”). That way, speckles are not 
converted but small text characters are.  Also, if there are many 
“touching” Characters, you may want to double or triple the Max 
Char Size so that gTCONVRT doesn’t ignore touching raster text. 

String Formation 
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Controls how gTCONVRT merges separated raster strings by inserting 
spaces in recognized text, how it breaks colinear text into separate 
BricsCAD text entities. 

Space Size 

Sets the distance between two characters (in terms of the percentage of 
a character’s width) required before a space character is inserted 
between the two text strings. 

Max # Spaces 

Sets the maximum number of the above-mentioned space characters 
allowed before gTCONVRT separates the text into separate BricsCAD 
text entities. If two text strings are far enough apart, they will exceed this 
“breaking point” and be portrayed by two separate BricsCAD text entities. 

Alignment Offset 

Sets the minimum vertical distance 
(relative to both of the text strings’ 
orientations) between separate lines 
of text in terms of a percentage of a 
typical character’s height. By default, 
this parameter is set to 0%, meaning 
that the top of one character could be 
level with the bottom of another and 
they would still be merged, into the 
same BricsCAD text string. 

Character Recognition 

Recognition Files Lists the .ICR 
files being used by gTCONVRT to 
recognize raster text. 

Open/New Opens a recognition 
file or creates a new recognition file 
and sets it for training. 

Close Closes the selected 
recognition file. 

Train Sets the selected recognition file for training. 
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Save Saves a trained recognition file. 

Word Recognition 

Dictionary Files 

OPEN or NEW – Opens an existing ASCII dictionary file (*.dct) or 
creates a new one from scratch. 

TOGGLE TRAIN STATUS – Controls whether the selected dictionary file 
is being trained.  When you make corrections during gTCONVRT, new 
words will be added to the dictionary file that is being trained.  These 
may later be edited with a standard text editor, such as Windows 
Notepad. 

CLOSE – Closes the selected dictionary file 

SAVE – Saves changes made to the selected dictionary file (only if it was 
being trained). 

Thresholds 

Verify – Controls the likelihood that gTCONVRT will display the text 
verification dialog to verify its guess at what a given word was.  If the 
average confidence of all characters in the text string falls below this 
value, the text verification dialog will appear. 

ForceFit – Controls how hard gTCONVRT will try to change characters to 
make a given string fit an existing dictionary file word or pattern. 

Text Output 

2. Text recognition works on one orientation of text at a time.  The 

default orientation is zero degrees. To recognize at 90 degrees, 

Delete 0 from the orientation list box, type 90 in the orientation text 

box and press [RETURN]. 

3. To use a pre-trained recognition file (suffix is .ICR) select Open. The 

Open Character Recognition/Training File dialog appears. 

Choose the .ICR recognition file and select OK. 

4. If you want to train this or any other opened recognition file on the 

new drawing, select TRAIN. The letter “T” will appear to the left of 

the training file. 
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Note: When you train a character recognition file, you will need to save it 
afterwards!  To save, go back into the text configuration dialog, 
select the Character Recognition pane, and Save. THE FILE IS 
SAVED ONLY AFTER YOU CLOSE OUT OF THE TEXT 
CONFIGURATION DIALOG!  After selecting SAVE, select OK to 
make the dialog save the file. 

5. If training a new recognition file, set the Auto-Convert Threshold to 

100 to force the Character Validation dialog to appear for every 

character. If working with an existing recognition file, a value of 70 to 

90 will be preferable so the dialog only appears for uncertain 

characters. 

6. Set the values for IOP minimum 

and maximum character size to 

limit the raster selected with Text 

IOP. 

7. The String Formation 

parameters should work well at 

the default settings. 

8. Leave the Save Raster button 

un-selected to keep raster text as 

it is being converted to BricsCAD 

text. 

9. Select OK.  

Orientation Sets the text orientations allowed to be recognized from 
raster text characters. The default list is established by the CharOrient 
parameter in GTXRAST.CFG. 

Ambiguous Characters 

Lists characters that could be easily misrecognized for another (i.e., the 
letter “O” could easily be drawn the same way as the numeral “0”. 
Therefore, it is common for each of these characters to be included in 
this list). 

Auto-Convert Threshold 



 

 166 

This is a simple but important parameter. It determines how frequently 
the gTCONVRT command asks you to validate its guess at characters. If 
the confidence level of a recognized character is below this Auto-Convert 
Threshold, then the Character Verification dialog will appear, allowing 
you to see the character for yourself and override the program’s attempt 
at recognizing the character. 

Note: 
1. The Auto-Convert Threshold is the Confidence Level above 

which a character must be recognized for it to be automatically 
converted to text without using the verification dialog. This is 
set by the CharThreshold parameter in GTXRAST.CFG. 

2. With a trained recognition file, gTCONVRT should accurately 
recognize legible characters. Recognition of text in messy 
drawings may be unreliable. 

3. gTCONVRT assigns a Confidence Level from 0 to 100 to each 

character. Confidence measures the degree to which a raster 
character matches those on which the recognition file has 
trained. 

Text Sizes Lists the sizes allowed for BricsCAD text resulting from 
raster text recognition during gTCONVRT. Resulting text will be snapped 
to the nearest perceived text size. The default list is established by the 
TextHeight parameter in GTXRAST.CFG. 

Save Raster If deactivated, gTCONVRT will delete raster text as it is 
converted to BricsCAD text. We recommend you normally leave this 
parameter on so the original raster text remains for final text checking 
purposes/QA. 
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gTCONVRT 

Type Menu Availability 
GTC or GTCONVRT GTX Convert/Text Convert 

 

GTXRaster CAD PLUS 

Icon:   

gTCONVRT converts raster text to BricsCAD text entities. Invokes the 
text editor window, allowing you to systematically check the results of the 
recognition process. This command can perform two tasks: 

 It converts selected raster text to BricsCAD text entities. 
Warning: The Character Verification dialog is actually a separate windows 

application. Because of this, if you happen to click somewhere 
within BricsCAD’s window, it will appear to disappear and lock 
up BricsCAD. Use [ALT-TAB] to return to the Character 
Verification application if this happens. 

 If a recognition file is set for training, it can train it on new text 

characters. 

CHARACTER RECOGNITION INSTRUCTIONS: 

1. Invoke gTCONVRT. 

2. If gTCONFIG has not yet been invoked during the BricsCAD 

session, gTCONVRT invokes it before beginning. 

Select raster <WINDOW>: 

3. Use the best IOP method for selecting the desired raster text. 

TextWin and TextLine were especially designed for this command, 

though Fence, Inside and Window also work. 

4. gTCONVRT recognizes and assigns a confidence level to each 

separate raster “blob” selected in step 3. 

5. Two kinds of characters will appear in the Character Verification 

dialog; (a) those that were recognized at a confidence below the 

Auto-Convert Threshold or (b) those that were listed as 

“Ambiguous” in the gTCONFIG dialog. 

Character Validation: character recognition thought this “D” was an “O”. 

6. Depending on the results of character recognition, accept or 
correct the character. 
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Using the Character Validation Dialog 
Program’s Guess Action 

Correct  Press Return 

Wrong Type the correct character(s) and press 

[RETURN] 

“Spurious” 

(The raster is not 

really a character) 

Select Ignore. 

Character will not be trained and will be 

recognized as a character. 

7. Characters whose confidence is above the Auto-Convert Threshold 

are automatically converted to BricsCAD text, bypassing the 

Character Validation dialog. 

8. gTCONVRT ends. To edit or change resulting text, use the 

BricsCAD Edit/Properties or Change commands. 

Options: 

Ignore Ignores the current character. Use this if a single character is 
represented by two separate pieces of raster - ignore one half and 
correct the other so the correct text is written. 

Cancel Ends recognizing all raster in the selection set. Returns to 
command prompt. No BricsCAD text entities result. 

Train CR Setting a recognition file for training in gTCONFIG 
activates a “Train CR” section in the lower left corner of the Character 
Verification dialog. 

If training a recognition file, the Character Verification dialog will train on 
each character that appears. If the raster that appears is a poor 
representation of that character (for example, a character that was 
scanned poorly and is either missing a part or is attached to some 
geometry), select No before accepting or correcting it. This way 
character recognition is not trained on misleading raster text. 

WORD RECOGNITION INSTRUCTIONS: 

To recognize words rather than individual characters, set the mode 
switch to Word on the Text Output pane of the text configuration dialog 
(See gTCONFIG, page 161). 

Word recognition otherwise works very similarly to character recognition, 
except that a word verification dialog appears instead of the character 
verification dialog.  You are given the opportunity to change the word 
before it is converted into BricsCAD text. 
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You can set a dictionary file to train during conversion.  This adds new 
words to the training dictionary, which is really just an ASCII text list of 
words that are likely to be in your drawings. Open BASE.DCT or 
USER.DCT in Notepad for an example. 
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gTEXT    

Type Menu Availability 
GTEXT GTX Edit>Raster Text GTXRaster CAD 

GTXRaster CAD PLUS 

 

(Raster Text) 

Icon:   

Type raster text in the current image aided by the Text Formatting 
control.  

Instructions: 

Command: gtext 

1.Specify start point of text: 

The start point is the bottom left point of the first character in the   
text string. 

2.Specify height: 

         Enter a numeric value for the height of the text characters. 

3.Specify rotation angle of text: 

Text can be entered at any orientation angle that is specified. The    
default angle is zero degrees. After selection of the rotation angle 
the Text Formatting control appears with the In-Place Text Editor. 
Begin adding text entries. The keyboard Return key will add a new 
line for text entry. 

  



 

 171 

4.To end editing click the OK button on the Text Formatting toolbar or 
click outside the In-Place Text Editor 

 After closing the text editor the raster text will appear. 

 -Raster text is created upon closure of the text editor 

 

-Raster text with a vector text overlay is created if the GTX gHybridmode 
command was enabled before initiating the gText command. 

 

 

../../AppData/Local/2012%20RCAD/2012UM/ghybridmode.htm
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gTRACE 

Type Menu Availability 
GT or GTRACE GTX Convert/Trace Vectors GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gTRACE traces over raster objects with vector entities. For a straight 
line, two points are picked to determine the extents of the raster line. 
Circles and arcs can also be copied to vector by picking three points. 

Note: If vectorizing raster geometry depicted in a special linetype, you 
might want to establish a current BricsCAD layer with that linetype 
first. The resulting vector geometry is placed on the current 
BricsCAD layer and is rendered in its linetype. 

Vector entities will be created using the current image and linetype 
settings. 

Options:  

Line Default option. Trace a raster line or series of lines with one 
vector line. Intersections are preserved. If points are picked beyond the 
endpoints of a line it will not be extended. 

Circle Trace a raster circle or series of arcs with a vector circle. A raster 
circle or arc selected with the “circle” option will be traced as a vector 
circle. 

Arc Trace a raster arc or series of arcs with a vector arc. If points are 
picked on a portion of a line or raster arc, only the portion between the 
points will be traced. You can use the “arc” option to trace part of a circle, 
part of an arc or a whole arc. 

Instructions: 

1. Select gTRACE. 

Select raster <LINE>: 

2. The default mode begins as “line”. Select another from the menu or 

type the first letter of the name and press [RETURN]. You will be 

prompted to select points. 

 

Using Line 
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a. Select the first point at one end of the line or line segments to be 
traced. 

Select other end of reference line: 

b. Select the second point on the opposite end of the line or line 
segments that you are tracing. 

c. Continue to trace another line or select another option. Press 
[RETURN] to exit the command. 

Using Circle 

a. At the prompt, select “circle” or type it followed by [RETURN]. 
You will be prompted to select three points to define the circle to be 
copied. 

Select point on circumference of circle: 

b. Select a point on the circumference of the circle. 

Select second point for circle: 

c. Select another point on the circumference of the circle. 

Select third point for circle: 

d. Select a third point on the circumference of the circle. The circle 
will be overlaid with a vector circle on the current BricsCAD layer. 
Continue to trace another circle or select another option. Press 
[RETURN] to exit from the command. 

Using Arc 

a. At the prompt, select “arc” or type it followed by [RETURN]. You 
will be prompted to select three points as if you were drawing a three-
point arc. 

Select start point of reference arc: 

b. Select a point at one end of the arc. 

Select point on arc: 

c. Select a point near the midpoint of the arc. 

Select end of reference arc: 

d. Rubber-band the arc so that it overlays the arc to be traced and 
select the point. 

Select raster <ARC>: 

e. The arc will be overlaid with a vector arc. Continue to trace 
another arc or select another option. Press [RETURN] to exit from the 
command. 
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gTRAIN 

Type Menu Availability 
GTR or GTRAIN GTX Convert/Text Train 

 

GTXRaster CAD PLUS 

Icon:   

While training files in gTCONVRT, mistakes can be made. gTRAIN 
searches through a recognition file and lets you correct or delete 
mistakes made during training. 

Warning: The Character Verification dialog is actually a separate windows 
application. Because of this, if you happen to click somewhere 
outside this dialog in the BricsCAD window it will appear to 
disappear and lock up BricsCAD. If this happens, use [CTRL-
ESC] or [ALT-TAB] to return to the Character Verification 
application. 

gTRAIN searches through a training recognition file for specified 
characters or orientations of characters and displays these in the 
Character Verification dialog. It displays each raster text sample, 
allowing you to keep, change or discard each character sample. 
Changes are stored to the recognition file when it is saved and closed 
within gTCONFIG. 

Note: If you select both of these options, gTRAIN will search for the 
specified characters at the specified orientations. 

Search Options:  

Training Characters Searches for specified characters. 

Orientations Searches for characters at specified orientations. 

Editing Options: 

Correct Replace the identity displayed by the Character Verification 
dialog with a new character identity (an “F” was trained as “P”; typing F 
will correct the typo). 

Keep Accepts the character evaluation of the sample raster text. 

Discard Discards the current sample raster text. 

Cancel Cancels the gTRAIN command, making no further changes. 
Changes before selecting Cancel are made to the .ICR file. 
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Instructions: 

1. Select gTCONFIG.  

2. The Text Configuration dialog 

appears. 

3. Open a recognition file or select 

one that is already loaded. 

4. Set the file to Train. “ON” appears 

below the Train button. 

5. Select OK. 

6. Invoke gTRAIN. The Text Training 

dialog appears: 

Text Training dialog 

7. If you leave the “Training Characters” and “Orientations” check 
boxes empty, gTRAIN will display every character in the training 
recognition file. The characters to be displayed can be limited to certain 
characters or orientations. 

8. To limit the search to only certain 

characters select Training 

Characters and select Edit 

List.... The Text Training 

Characters dialog appears: 

Text Training Characters dialog 

9. Build a list of individual characters to observe with gTRAIN. 
Enter characters separately.  

Note: If you enter a multi-character string the command will search for 
raster characters that have been recognized as that string (i.e., you 
could type the unicode \U+2205 to search for the unicode text 
diameter symbol if you had previously trained that using 
gTCONVRT). 

10. To limit the search to characters at specific orientations check the 

Orientations box and select Edit list.... The Text Orientations dialog 

appears: 
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Text Orientations dialog 

11. Add each required orientation 
to the list, then select OK. 

12. Back in the Text Training dialog, 

verify that the lists are correct, 

then select OK. The Character 

Verification dialog appears: 

Character Verification dialog 

The dialog will present each raster text sample, its trained identity and its 
orientation (i.e., In 104, the raster is displayed in the top half of the dialog 
and the character is recognized as the number “7” at 45 degrees in the 
lower half). 

If the evaluation is correct, as with gTCONVRT, press [RETURN] or 
select KEEP to accept the identity of the raster text sample and proceed 
to the next sample. 

If the evaluation is incorrect, but is still a good example of that character 
at its orientation, make the necessary corrections to the text id and its 
orientation, then press [RETURN] or select KEEP to make the change 
and proceed to the next sample. 

If the evaluation is incorrect and is also a bad example (unidentifiable or 
at least very messy) select Discard to remove the text sample from the 
recognition file. 

To cancel the gTRAIN command, select [CANCEL]. All changes made 
prior to cancelling the command will have been saved in memory.  

To Keep Your Changes  

gTRAIN does not automatically save changes to the recognition file. To 
write the changes to the file invoke gTCONFIG and save the training 
recognition file. If you choose to keep the recognition file as it was when 
it was first loaded, you can close it without saving changes. 
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gTURN 

Type Menu Availability 
GTU or GTURN GTX Enhance/Turn GTXRaster CAD & 

GTXRaster CAD PLUS 

Icon:   

gTURN quickly rotates raster data in the active image by a multiple of 90 
degrees. This also swaps the image’s X and Y raster limits. 

This command is useful when you are working with images that have 
been scanned sideways and appear sideways when attached within 
BricsCAD. 

Options: 

90 Rotate the raster data counterclockwise 90 degrees. 

180 Rotate the raster data counterclockwise 180 degrees. 

270 Rotate the raster data counterclockwise 270 degrees. 

Instructions: 

1. Select gTURN. 

Specify rotation angle <90>/180/270: 

2. Enter the angle or press [RETURN] for the default. The image raster 

data is rotated. 
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gVECTOR 

Type Menu Availability 
GV or GVECTOR GTX Convert/Draw Vectors 

 

GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gVECTOR traces raster with lines, arcs or circles like gTRACE. Unlike 
gTRACE, gVECTOR erases originating raster data. 
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gVSKEW 

Type Menu Availability 
GVS or GVSKEW GTX VClean/Skewline GTXRaster CAD PLUS 

Icon:  

gVSKEW straightens skewed lines so they become orthogonal (at a 0 or 
90 degree angle). 

Instructions:  

Select objects: 

Select lines to deskew. 

Enter tolerance angle (1-10)<1.00>: 

Enter the degrees of tolerance for deskewing lines. 

Lines within that tolerance of 0 or 90 degrees are straightened. 
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gWARP 

Type Menu Availability 
GW or 

GWARP 

GTX Enhance/Warp GTXRaster CAD 

GTXRaster CAD PLUS 

Icon:  

gWARP corrects distortion in a raster image by stretching the image data 
between source and destination points. 

Options:  

The Image Warp dialog establishes warp source and destination point 
pairs.  These point pairs define the way the image is to be stretched. 

Add Point Pairs creates one pair at a time. 

Generate Grid creates a lower left corner, an upper right corner, and 
intermediate grid points. 

Instructions: 

Warping requires the definition of source and destination point pairs.  
When CMDDIA is set to 1, the Image Warp dialog allows the creation of 
individual point pairs or an entire array of them.  When CMDDIA is set to 
0, a series of prompts gathers the same information. 

Add Point Pairs 

The Add Point Pairs button lets you add individual pairs of source and 
destination points.  

Source point on the drawing (1): 

1. Type or select a point on the image representing a known 

coordinate. 

Warp point (#.###,#.###):  

2. Type or select the real location to which the source point is to be 

warped or displaced. 

Source point on the drawing (2): 

3. Enter another source point or press [RETURN] to go back to the 

Image Warp dialog. 

The specified points appear in the Coordinate List Table. 
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Generate Grid 

The Generate Grid button lets you create a rectangular grid of 
destination points and then for each point, enter the source points. This 
is backwards from the prompts for Add Point Pairs, but it provides a 
convenient way of generating a list of known real coordinates and then 
provides the location of each of those features in the raster image. 

Select base point of grid: 

1. This point may be the lower left corner of the image, or one corner of 

a grid of known coordinates. 

Select opposite corner of grid: 

2. Select the corner opposite the base point.  This defines the total area 

the grid will occupy. 

Select first corner for cell size: 

3. Select one corner to define the cell size.  This might be the same 

point as the base point. 

Select opposite corner for cell size: 

4. Select the other corner of the cell to define its overall size.  The grid 

will fill up with cells whose size is defined by the first and opposite 

corners. 

For each grid point generated by steps 1-4, the following prompt will 
appear: 

New source point on the drawing (#.###,#.###): 

5. A line will be rubber-banding from one of the grid points.  Select the 

raster point nearby that is supposed to be representing this real point 

in space. 

When all the grid (destination) points have prompted for their respective 
source points, the Image Warp dialog will re-appear showing the entire 
list of point pairs in the Coordinate List Table. 

Save List 

The Save List button saves the list of point pairs in an ASCII text file.  
The default filename is warp.txt. 

Delete Point Pair 

Deletes the selected point pair in the Coordinate List Table. 

Modify Point Pair 
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Re-enters the selected point pair in the Coordinate List Table. 

Clear All Points 

Erases ALL point pairs in the Coordinate List Table. 

Prompt Instructions 

When CMDDIA = 0, the following prompts are issued instead of 
command dialogs. 

Enter number of warp points: 

Enter the number of warp points for gWARP to create. 

Source point on the drawing (1): 

Select or enter the coordinates of the first source point.  This will be the 

location in the raster image that will be stretched to a new 

(destination) position. 

Warp Point (#.###,#.###): 

A rubber-banding line will stretch from the source point to the cursor.  

Select or enter the coordinates of the destination point.  This will be 

the location to which the source point is to be stretched. 

Source point on the drawing (2): 

Continue entering source and destination point pairs until all the warp 

points are done.  

Now warping image 
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Appendix 1:  Glossary of Terms 

Term Definition 

Active Image The image currently prepared by the GTXRaster CAD series 

for raster editing or conversion. 

ASCII American Standard Code for Information Exchange - 

Pronounced “Ask-ee”.  The code used by most computers to 

represent text. 

Attach BricsCAD lets you “attach” an image within a drawing.  The 

raster data is not stored in the image - instead, an image 

entity “points” to the raster file on disk. 

Auto-Convert Threshold The confidence level above which gTCONVRT will 

automatically convert a raster character into ACAD text 

without using the Character Verification Dialog. 

AutoSnap™ BricsCAD’s method of dynamically snapping the crosshair to 

vector objects 

Character Verification The QA process that lets the user verify that ICR correctly 

creates ACAD text entities, even if it guesses the character 

wrong. 

Confidence Level A number between 1 and 100 representing the degree to 

which a character matches those it has already seen. 

Contours Continuous curves that can be represented by the polyline 

(or pline) vector entities.  Typically found on topographical 

maps. 

Demand Loading The GTXRaster CAD series executable can “Demand Load” 

so it doesn't load as soon as BricsCAD starts.  Instead, it 

waits for a GTX command to be issued, and then it loads.  

Read the GTX manual for instructions on Demand Loading.  

See your BricsCAD documentation for more information 

about Demand Loading. 
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Term Definition 

Deskew To rotate a raster image so that it is no longer skewed. 

Despeckle To remove speckles or small marks that contain no 

meaningful information from a drawing. 

Display Color The color in which unselected raster is displayed. 

DPI Dots Per Inch -The number of dots per linear inch, 

calibrating a raster image to real space. 

Highlight Color The color in which selected raster is displayed. 

ICR Intelligent Character Recognition - Conversion of raster text 

into ACAD text entities. 

Integer A number evenly divisible by one (1,2,3,4,5 are integers.  

1.25, 3/4, and .05 are not integers). 

IOP Intelligent Object Picking™ - The proprietary method by 

which RCAD series selects raster shapes from a scanned 

drawing as if they were distinct vector entities. 

Object Snapping ACAD mode of snapping the cursor to a point relative to 

vector geometry. 

Pixel Pixels, or “Picture Elements”, are the tiny dots with which a 

scanner portrays a drawing. 

Polyline Smooth Index A number representing the smoothness of polylines 

generated when vectorizing raster contours. 

Raster File Pixel data from a scanned drawing stored as a file.  There is 

a wide range of standards and formats for raster files. 

Raster Limits The area in a raster image in which features can exist; the 

extents of a raster database. 

Raster Snapping The ability to pick a point relative to raster geometry, such as 

snapping to the end of a raster “line”. 

Rasterize To convert an BricsCAD vector object into raster format. 
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Term Definition 

Scanner A device which converts a drawing into raster data by 

measuring and recording the intensity of light that is reflected 

from it. 

Skewed Slightly rotated.  When a drawing is fed slightly crooked into 

a scanner, the resulting raster image is skewed. 

Transparent Zoom The ability to change your view of a drawing while in the 

middle of a command.  Type: 'Z, [RETURN].  ACAD starts 

Zoom command.  Old command resumes upon completion. 

Vectorize To convert raster data into vector format, as used in a CAD 

environment. 
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Appendix 2:  Configuration 

The GTXRaster CAD Series receives many of its default values from a 
configuration file, GTXRAST.CFG. This ASCII file can be modified with a 
text editor such as Notepad. The list below shows the default contents of 
GTXRAST.CFG if you had installed it for using inches. The entries can 
be listed in any order. 

Here is a standard configuration file: 

REM * GTX Configuration * 

 

REM ** Use “REM” or “rem” for comment lines, blank lines are ok. ** 

REM **Defines inch or millimeter measurement standard** 

DrawingUnits 1Inch=1 

 

REM **Defines the default path for saving raster files.** 

RasterPath =CURRENT DIRECTORY 

 

REM **Used with gCreate and color images when gActivated.** 

RasterFormat =TIF 

 

REM **Defines the available raster file formats that will be loaded with 

an BricsCAD  

REM **open when a raster file with the same name is in the same directory. 

RasterLoadExt = TIF CG4 RLC BMP PCX PNG * 

 

REM **The maximum size an image can be created or actived. 

REM **Number of pixels = DPI * DPI * ImageHeight * ImageWidth.  

REM **This limit (973440000) could create a 400DPI 78” X 78” image. 

REM **If set to 0 it's unlimited - warning could exceed memory capacity. 

MaxNumPixels=973440000 

 

REM **Defines the marking color for selected raster in editing.  Can use 

any color from 0-255.** 

HighlightColor =GREEN 

 

REM **Defines the width of rasterized vector objects.** 

RasterWidth =0.01 

 

REM **Yes option creates a backup of the original raster file.** 

BackupRas =NO 

 

REM **Yes option saves the vector entity when doing Gburn or Graster.** 

SaveVector=NO 

 

REM **Defines the Backup Raster Extension for the BackupRas variable. You 

must put a '.' before the extension.** 
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BackupRasExt=.GTX 

 

REM **Defines the Dot Per Inch resolution within the raster limits.** 

REM **Used for gcreate.** 

Resolution =200 

 

REM **Set the number of undos that are stored. Not available at this 

time** 

REM MAXUndo=3 

 

REM **Sets the subformat to be used when saving TIFF files.**   

REM Subformat    Value 

REM TIFF G3   1 

REM TIFF G4 Stripped  2 

REM TIFF Uncompressed   3 

REM TIFF G4 Monolithic  4 

REM TIFF G4 Tiled   5 

TiffFormat = 2 

 

REM **Disables a specific command.  Multiple variables can be set but must 

be on separate lines.** 

REM disable=gattach 

REM disable=gload 

 

REM * Text Configuration * 

REM **Sets a recognition file for GTXRaster CAD PLUS to automatically load 

when it runs.** 

REM CharFile =c:\program files\gtx\raster cad 2021\g_u_0.icr 

 

REM **Sets a character to be listed in the ambiguous characters list box 

in the gTConfig dialog.** 

REM Ambigchar =I 

 

REM **Sets the initial value for the Orientation list in the gTConfig 

dialog.**  

CharOrient =0 

 

REM **Sets the initial value of the AutoConvert Threshold setting in the 

gTConfig dialog.** 

CharThreshold =100 

 

REM **Sets the initial value for the Min Char Size in the gTConfig 

dialog.** 

CharMinSize =0.04 

 

REM **Sets the initial value for the Max Char Size in the gTConfig 

dialog.** 

CharMaxSize =0.4 

 

REM **Sets the initial value for the Space Size setting in the gTConfig 

dialog.** 

CharSpaceSize =1.0 
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REM **Sets the initial value for Alignment Offset setting in the gTConfig 

dialog.** 

CharAlign =0 

 

REM **Sets the initial value for Text Height setting in the gTConfig 

dialog.** 

TextHeight =0.2 

 

REM **Sets the initial value for Max # Spaces setting in the gTConfig 

dialog.** 

MaxSpaceSize =1 

 

REM **Sets the initial value for the word-mode verification level. 

WordVerifyLevel =100 

 

REM **Sets the initial value for the word-mode force-fit level. 

WordForceLevel =0 

 

REM ** 0 means touching character recognition is OFF, 1 means ON 

TouchingCR =0 

 

REM ** 0 means word mode CR, 1 means character mode CR 

CRMode =1 

 

REM ** Character similarity file for word recognition 

REM SimFile = c:\program files\gtx\raster cad plus 2021\gtxtext.sim 

 

REM ** dictionary file for word recognition 

REM WordFile =c:\program files\gtx\raster cad plus 2021\base.dct 

REM WordFile =c:\program files\gtx\raster cad plus 2021\User.dct 

 

REM ** sets the default GAP JUMP size 

REM GAP_SIZE_TO_JUMP = 50 

 

REM ** sets the layer name to be created during hatch recognition 

HATCH_LAYER_NAME = HatchLayer 

 

REM ** sets the layer name to be created during linestyle recognition 

LINESTYLE_LAYER_NAME = LinestyleLayer 

 

REM * Line Width Configuration * 

REM **Defines the rasterized vector width for particular colors.  Can use 

any color from 0-255.** 

Pcolor 1=0.010 

Pcolor 2=0.020 

Pcolor 3=0.030 

Pcolor 4=0.040 

Pcolor 5=0.050 

Pcolor 6=0.060 

Pcolor 7=0.070 

Pcolor 8=0.080 

Pcolor 21=0.090 

Pcolor 23=0.100 

Pcolor 30=0.110 

Pcolor 41=0.120 
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Pcolor 63=0.130 

Pcolor 153=0.140 

Pcolor 201=0.150 

Pcolor 161=0.160 

 

REM **Set PclrUnit=0 if you want to multiply your pcolor setting by the 

BricsCAD scale of the Image. 

REM **Set PclrUnit=1 if you do NOT want to multiply your pcolor setting by 

the BricsCAD scale of the Image. 

PclrUnit=1 

 

REM **Product level. Settings include RCAD, RCADPLUS.** 

ProductLevel=RCADPLUS 

Demomode=NO 

 

REM **If equal to 0, it sets zero-width polylines to be rasterized just as 

all other entities.  

REM **If set to 1 all plines will be rasterized as 1 pixel wide.** 

Zero_Pline=0 

 

REM **Determines the number of minutes of idle time the GTXRaster CAD 

series license server  

REM **will allow before de-activating an inactive license and making it 

available again.** 

REM **Value must be at least 60. ** 

HaspTimeOut=120 

 

REM **Specifies the type of HASP security key being used. Possible 

settings include 

REM DEFAULT, JAPAN_NEC, JAPAN_IBM.** 

Hasp_Type=DEFAULT 

 

REM **Set RefDelLoad=1 if ref file needs to be deleted on doing a gATTACH, 

set to 0 otherwise** 

RefDelLoad = 0 

 

REM **Images are placed on this layer when attaching. 

REM **The current layer is used if no layer name is listed. 

DefaultRasterLayer=RASTER 

 

REM ** Defines the layer color for the layer named in the 

REM ** DefaultRasterLayer config parameter. 

REM ** Can use any color from 0-255. 

RasterColor = RED 

 

REM ** Set to 'YES' when another 3rd party application will also be   * 

REM ** editing raster images.  This will cause more overhead to keep  * 

REM ** keep RCAD in sync with the 3rd party application raster edits. * 

REM ** Default is NO.                                                 * 

3P_APP_EDIT=NO 

 

REM ** When set to 'YES', RCAD will not perform transparent saving ofREM 

** edited raster images. 

REM ** Useful when another 3rd party application will also be 

performingREM ** transparent saving. 
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REM ** Default is NO. 

3P_APP_SAVING=NO 

 

 

REM **  

REM ** A raster image attached with the 'gattach' command willREM ** 

automatically be the active image (gactive) when the parameter 

REM ** is set to YES. 

REM ** Default is YES. 

GACTIVE_ON_GATTACH=YES 

 

REM ** Keep the following setting at 'YES' to prevent 

REM ** holes from forming in the warped image 

WARP_CORNER_PTS=YES 

 

AUTOATTACH=YES 

 

REM ** GHYBRIDMODE Enables vector overlay of drawn raster lines, arcs, 

circles, rectangles      

REM ** and text. 

REM ** is set to = Yes or No. 

REM ** Default is No. 

HYBRIDMODE =No 

 

REM ** PDF files created by GPDFSAVE will have the PDF author property set 

to this string; usually the drafter, group or company name 

PDF_AUTHOR=GTX Corporation 

Customizing 

The GTXRaster CAD Series uses BricsCAD profiles to determine the 
location of program files. You can create multiple versions of 
GTXRAST.CFG and have an BricsCAD profile for each one. Looking at 
the properties of the GTXRaster CAD Series icon you will see: 

""C:\Program Files\Bricsys\BricsCAD V21 en_US\bricscad.exe" 

/p "GTXRCAD PLUS  2021 BricsCAD" 

The standard GTX profile is called “GTX”. Use BricsCAD’s Options 
command to create copies of the GTX profile, modifying the paths and 
filenames as required. The GTXRaster CAD Series will use the first 
configuration file it encounters. 

When BricsCAD is invoked, the GTXRAST.CFG file is checked. If the 
program does not recognize an entry (for example, RsterForm=) or if a 
value is invalid, you will get an error message. Any invalid entry is 
ignored and the program’s default value is used instead. 



 C O N F I G U R A T I O N  

 191 

Configuration Entry Descriptions 

The configuration file entries are explained below and valid entries are 
given. Any items not included in the file or not given a value will use the 
default values. 

Basic Configuration Parameters 

DrawingUnits This entry has two functions. It defines whether 
configuration values should be inches or millimeters and also how the 
World Coordinate Units should be applied to the raster image. The raster 
image can be either “1inch” or “1mm”; the other linear measurements in 
the configuration file will be in the same unit (i.e., if you specify “mm” the 
RasterWidth parameter will express millimeters and the value should be 
adjusted accordingly). The DrawingUnits value defines what inch or 1 
mm on the raster image maps to in BricsCAD units. The value entered 
must be a real number. This defaults to BricsCAD’s initial units value. 

RasterPath Defines the default path for saving raster files. You can 
override the directory entered here by entering the full path when 
prompted for a file name. The default is to save the file in the current 
directory. 

RasterFormat Defines the default storage format of new raster files.  
This is used by gCREATE and when using gACTIVE on color images. 

RasterLoadExt Defines the available raster formats that will be loaded 
with BricsCAD open when a raster file with the same name is in the 
same directory. 

MaxNumPixels Sets the maximum number of pixels allowed in a new 
raster image. Default setting is 973,440,000, which at 400 dpi is 
equivalent to 78 x 78 inches or 2090 x 2090 millimeters. 

HighlightColor Defines the default color used to highlight selected raster 
data. Choose a color that can be seen against the raster image and 
against the background color. Valid entries are the same for RasterColor. 
The color can be changed with the gCOLOR or gLAYER commands. 
The default is GREEN. 
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RasterWidth Sets the default raster line width to be used when vector 
entities are converted to raster. The entry should be an appropriate real 
number, or T if you want to specify the Line Width Table values. The 
default is .01. This value will be in inches or mm according to the 
DrawingUnits entry. All the values can be reset when you use the 
gRASTER command. 

BackupRas “Yes” causes raster save to create a backup raster file. 
“No” deactivates the backup option. 

BackupRasExt Sets the file extension for backup raster files. 

Resolution Defines the default resolution for new raster images.   

MaxUndo Sets the number of raster undos that are stored. 

Tiffformat Sets the subformat to be used when saving TIFF files: 

TIFF G3 1 

TIFF G4 2 

TIFF UNCOMPRESSED 3 

Disable  Disables a specified command. Enter a single command 
name (i.e., gMOVE) after the word “Disable”. The software will not allow 
the user to invoke the specified command. To disable multiple 
commands, add more Disable [Command Name] lines to the 
configuration file. 

Text Configuration Parameters 

CharFile sets a recognition file for GTXRaster CAD PLUS to 
automatically load when it is run. If you want the program to load multiple 
recognition files, add more CharFile [Recognition File] lines to the 
configuration file. 

AmbigChar sets a character to be listed in the ambiguous characters list 
box in the gTCONFIG dialog upon starting GTXRaster CAD PLUS. 
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CharOrient sets the initial values for the Orientation list in the 
gTCONFIG dialog, determining the allowed orientations for building 
BricsCAD text entities. The default setting is 0. Valid entries are any 
angle between -360 and 360 degrees. 

CharThreshold sets the initial value of the AutoConvert Threshold 
setting in the gTCONFIG dialog. This is the character confidence level 
above which the character verification dialog appears. The default value 
is 100, which makes the character verification dialog appear every time. 
Valid entries are integers from 0 to 100. 

CharMinSize sets the initial value for the Min Char Size setting in the 
gTCONFIG dialog, determining the minimum value for raster text 
characters when using Text IOP or gTCONVRT. The default value is .04. 

CharMaxSize sets the initial value for the Max Char Size setting in the 
gTCONFIG dialog, determining the maximum value for the raster 
characters when using Text IOP or gTCONVRT. The default value is .4. 

CharSpaceSize sets the initial value for the Space Size setting in the 
gTCONFIG dialog, defining the distance between raster characters in 
terms of a typical character’s width necessary for gTCONVRT to insert a 
space character. The default value is 1.0. Valid entries are any positive 
real number. 

CharAlign sets the initial value for the Alignment Offset setting in the 
gTCONFIG dialog, determining the minimum vertical distance, relative to 
the text strings’ orientations, between separate lines of text in terms of a 
percentage of a typical character’s height. The default setting is 0. Valid 
entries are any real number. 

TextHeight sets the initial value for the TextHeight value in the text 
configuration dialog. 

MaxSpaceSize sets the initial value for the Max # Spaces setting in the 
gTCONFIG dialog, determining the maximum number of spaces that can 
be inserted into a text string by gTCONVRT before it breaks the text 
string into two separate BricsCAD text entities. The default setting is 1. 
Valid entries are integers 1 through 100. 

MaxSpaceSize sets the initial value for the Max Space Size dialog. 
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WordVerifyLevel Sets the initial value for the word-mode verification 
level. 

WordForceLevel sets the initial value for the word-mode force-fit level.  

TouchingCR controls whether ICR splits touching characters.  0 means 
OFF, 1 means ON 

CRMode controls whether ICR is performing Character recognition or 
Word recognition.  0 means word mode CR, 1 means character mode 
CR 

SimFile establishes the character similarity file to use for word 
recognition.  Gtxtext.sim is hardcoded into GTX, but if another file is 
loaded it will override the default similarity settings. 

WordFile establishes the dictionary file(s) to load on startup. 

Raster-to-Vector Conversion Parameters 

GAP_SIZE_TO_JUMP sets the default GAP JUMP size. 
HATCH_LAYER_NAME sets the layer name to be created during hatch 
recognition. 
LINESTYLE_LAYER_NAME sets the layer name to be created during 
linestyle recognition 

PColor Establishes a value in the line width configuration table. 

 Pcolor [Color Value]=0.050 [Line Width] 

PClrUnit Determines behavior of linewidth color table when 
rasterizing or vectorizing with a scaled image. Set PclrUnit=0 if you want 
to multiply your pcolor setting by the BricsCAD scale of the Image.  Set 
PclrUnit=1 if you do NOT want to multiply your pcolor setting by the 
BricsCAD scale of the image. 

Other Parameters  

ProductLevel sets the product level for the GTXRaster CAD series to 
run.  Settings include RCAD, RCADPLUS. 
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DemoMode Determines whether GTXRaster CAD operates in 
demonstration mode.  Although GTXRaster CAD will revert to demo 
mode if a the software has not been activated or the license expired.  If 
you install GTXRaster CAD specifically for demonstration purposes, 
DemoMode=YES causes it to automatically enter demonstration mode 
without this delay.  DemoMode=NO (default setting) causes GTXRaster 
CAD to look for the license when it first runs. 

Zero_Pline Determines how polylines of zero width are rasterized.   
0 causes zero-width plines to rasterized like other entities.  1 causes 
them to rasterize at 1 pixel wide. 

HaspTimeOut Determines the number of minutes idle time the 
GTXRaster CAD Series license server will allow before de-activating an 
active license and making it available again.  Must be at least 120. Not 
applicable to the 2021 Version. 

Hasp_Type Specifies the type of HASP security key being used. 
Available settings are: Default, Japan_IBM and Japan_NEC. Not 
applicable to the 2021 Version. 

RefDelLoad Specifies the behavior of gATTACH as it loads a raster 
file with an associated .REF file. If set to 1, the .REF is deleted. If set to 
0, the .REF file is kept. 

DefaultRasterLayer establishes the name of a layer on which images 
are placed when attached using gATTACH. 

RasterColor defines the layer color for the layer named in the 
DefaultRasterLayer config parameter.  Any color from 0-255 can be 
used. 

3P_APP_EDIT should be set to Yes when another 3rd party application 
will also be editing raster images.  This will cause more overhead to keep 
RCAD in sync with the 3rd party application raster edits.  When set to 
'YES', RCAD will not perform transparent saving of edited raster images. 

3P_APP_SAVING is used when another 3rd party application will also 
be performing transparent saving. 

GACTIVE_ON_GATTACH controls whether a raster image attached with 
the gATTACH command should automatically become active 
(gACTIVE).  
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Line Width Configuration 

The line width configuration table is important to several functions of the 
GTXRaster CAD Series. Because BricsCAD vector entities have no line 
width, the GTXRaster CAD Series lets you assign raster line widths to 
BricsCAD vector colors. 

When converting raster to vector, gCONVRT can assign different colors 
to vectors resulting from different raster line widths. The gRASTER 
command converts vector data to raster. When rasterizing, BricsCAD 
vector entities of different colors can be rasterized to different line widths. 
When smoothing raster the gSMOOTH command can snap raster data 
to the closest line width listed in this table. 

The format for listing a color/linewidth listing is: 

Pcolor Color# = LineWidth 

in which Color# is the BricsCAD color number to be associated with the 
raster linewidth. LineWidth is the width of the raster line (this can be 
measured using the BricsCAD Dist command).  

PDF_AUTHOR PDF files created by GPDFSAVE will have the PDF 
author property set to this string; usually the drafter, group or company 
name. PDF_AUTHOR=GTX Corporation 
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Appendix 3:  Raster File Formats 

BricsCAD allows you to attach images in a limited number of formats: 

Type Description and versions File extension R/W 
BMP Windows and OS/2 bitmap 

format 

.bmp, .dib, .rle R/W 

CALS-I Mil-R-Raster I .gp4, .mil, .rst, .cg4, .cal R/W 

GIF CompuServe Graphics 

Exchange Format 

.gif  R/W 

JFIF  .jpg R/W 

FLIC Animator FLIC .flc, .fli R 

PCX  .pcx R/W 

PICT  .pct  R 

PNG  .png R/W 

TARGA  .tga R/W 

TIF/LZW  .tif R/W 

The following table shows the Rastrans utility read/write formats: 

Raster Format Ext. Read Write 
Adobe PostScript ps - - 

Boeing Bedmics B4 X X 

GTX Uncompressed Runlength rnl X X 

CalComp Raster Format crf - - 

CCITT G3-GTX Header g3 X X 

CCITT G4-GTX Header g4 X X 

CImage Corp. dsi X  

EDMICS Tiled G4 c4 X X 

Formtek img Img X  

JEDMICS    

FileNET G4 Tiled img X X 

FileNET G3 Tiled img X  

FileNET G4 Banded img X  

FileNET G3 Banded img X  

GraphTEC RLC rlc  X 

HP Deskscan tif X X 
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Raster Format Ext. Read Write 
HP Printer Control Language pcl - - 

HP Raster Transfer Language rtl - - 

PC Paint format pcx X X 

Image Systems Runlength rlc X  

Image Systems Runlength 2 rlc  X 

Japan Digital Labs 4000E jd4 - - 

Japan Digital Labs jdl - - 

CCITT G3-TIFF tif X X 

CCITT G4-TIFF tif X X 

Cals G4 - (MIL-STD-28002A) 

(28002 Type I supported. 28002 Type II not supported) 

cg4 X X 

Oce Graphics/NKK (Japan) oce - - 

Optigraphics TIFF opt - - 

Raster Graphics rle - - 

TIFF Uncompressed tif X X 

TIFF Version 6 Tiled tif X X 

TIFF Packbits tif X  

Versatec Block Format vbf - - 

Versatec VDS vds - - 

Fuji/Xerox MMR mmr X X 

Intergraph cit X X 

 

Note: The PCX file writer provided by BricsCAD does not facilitate the 
saving of the resolution of the file. Files of this type are loaded 
without a resolution and the gINFO command cannot report a 
resolution. The GTXRaster CAD Series software can save a PCX 
file into any of the other GTX supported file formats with a 
resolution of 200 dpi. When saved to another format, the file will 
always have a default resolution of 200 dpi. 

 

 

 

 

. 
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Rastrans Raster Format Translator V5.0 

The Raster Format Translator (RASTRANS) is a stand-alone utility 
included with the GTXRaster CAD Series the same input/output formats 
as GTXRaster CAD. Rastrans translates raster files from one raster 
format to another. It can scale translated files separately in the X and Y 
axes. GTXRaster CAD series includes both Windows and DOS versions 
of GTX Rastrans.  The DOS version lets you create DOS batch scripts. 

Windows GUI Version 

 Rastrans is the executable, 
Rastrans.exe, located in the GTX 
directory. 

RASTRANS MAIN SCREEN 

Upon running Rastrans, the main screen will appear. 

The left side of the Rastrans main screen contains the Input Files List, 
showing all the raster files to be translated. 

INPUT FILES LIST 

This list box displays the files to be batch-translated to the selected 
output file format. 

ADD FILES 

Select to add raster files to the Input Files List. 

Select any or all files to be translated into the Output File Format. 
Multiple files can be selected by holding [Shift] or [Control] while using 
the left mouse button to pick more than one file at a time. 

REMOVE FILES 

Removes files from the Input Files List. 

ABOUT RASTRANS 

Displays copyright information. 
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OUTPUT FILE DIRECTORY 

Specifies output directory for translated files. Selecting Use Input File 
Directory sends output to the same directory as the source files. 

OUTPUT FILE FORMAT 

Displays the file format to which input files are to be translated. Selecting 
Print to [Your Printer] sends the output directly to the current Windows 
system printer. Scale may need to be adjusted to fit a drawing. 

DPI 

Use Original DPI sets resulting raster output at the same DPI as the 
input file. New DPI specifies an override dpi for output files. 

RESOLUTION 

Use Original Resolution sets resulting raster output at the same 
Resolution as the input file. New DPI specifies an override resolution for 
output files. 

TRANSLATE 

Begins translating input files into files of the output file format in the 
specified output directory. 

QUIT 

Exits Rastrans. 

RESTART 

After translating, the Translate button is renamed Restart. Clears the 
Input Files List, allowing you to do another batch conversion if desired. 

RASTRANS.PDF 

For additional documentation, refer to Rastrans.pdf located in the GTX 
directory. 

DOS Version of GTX Rastrans 

GTXRastrans is also available as a DOS application. 
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USAGE: 
Rastrans infilename {outfilename|lpt1|lpt2|lpt3} [-rof 

{calsg4|gtxg3|gtxg4|tiffg4|tiffg3|tiffu|tiled|rnl|rlc|jd

l|crf|rtl|pcl|vbf|ps|opt|pcx|rle|nkk|grphtec|hpg}] [-dpi 

input resolution] 

 

Argument Description 
Infilename raster input filename 

Input file types are autodetected independent of file extension (except b4, 

c4, rlc) 

Input file types recognized are gtxrnl, gtxg3, gtxg4, calsg4, tiffg3, tiffg4, 

tiff packbit, tiff uncompressed, tiled tiff, rlc, rlc2, dsig4, pcx, filenet img, b4, 

c4, cit 

Outfilename the raster output filename 

-rof optional – specifies the output file format type 

-dpi optional – input resolution (50 to 10000) 

-xdpi optional - output x resolution (50 to 10000) 

-ydpi optional - output y resolution (50 to 10000) 

-odpi optional - output x and y resolution (50 to 10000) 

-rot optional - rotation of 90, 180, or 270 
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=== COPYWRITE C R E D I T S  &  D I S C L A I M E R S === 

 

CQuantizer is used by GTX to generate PNG image files and was written by Jeff Prosise and David Pizzolato .Permission is given by the author to 
freely redistribute and include this code in any program as long as this credit is given where due. 

CQuantizer (c)  2096-2097 Jeff Prosise 

COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE COVERED CODE IS FREE OF DEFECTS, MERCHANTABLE, 
FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
COVERED CODE IS WITH YOU. SHOULD ANY COVERED CODE PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL 
DEVELOPER OR ANY OTHER CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS 
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY COVERED CODE IS 
AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER.      Use at your own risk! 

31/08/2003 Davide Pizzolato - www.xdp.it 

 - fixed minor bug in ProcessImage when bpp<=8 

 - better color reduction to less than 16 colors 
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gACTIVE ............................................................... 54 

gINACTIVE ......................................................... 113 
Automatic Clean Up ................................................... 77 

B 

Batch raster conversion 
gOSR .................................................................. 127 

Burn to raster 

See gBURN, gRASTER ......................................... 64 
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Change raster ............................................................. 73 

Character recognition 
See Converting, Raster text .................................. 182 

Clipping Boundary ..................................................... 54 

Color Images 
Reduction to Bitonal .............................................. 54 

Command Overview .................................................. 35 

Configuration File .................................................... 202 
Parameters ............................................................ 209 

Configure Text ......................................................... 176 

Converting 
Polylines vs. Line/Arc/Circle ................................. 80 

Raster text 

gTCONVRT ..................................................... 182 
gTRAIN ........................................................... 200 

Raster to vector 

gECONVERT .................................................. 103 
Raster to Vector 

gCONVRT ......................................................... 80 

Vector to raster 
gRASTER ........................................................ 139 

Copying raster 

gARRAY ............................................................... 57 

gCOPY ................................................................... 85 
gCUT ..................................................................... 96 

gOFFSET ............................................................. 126 

gPASTE .............................................................. 127 

Creating new raster images 
gCREATE .............................................................. 88 

Cropping raster 

gCROP ................................................................... 89 
Custom Configuration .............................................. 206 

Cutting and pasting raster 

gCUT ..................................................................... 96 
gPASTE .............................................................. 127 

D 

Deskewing raster 

Auto deskew ........................................................... 55 
gDESKEW ............................................................. 99 

Despeckling 
gSPECKL ............................................................. 174 

DPI ........................................................................... 114 

Maximum Pixels .................................................... 88 
Draw order ............................................................... 102 

Drawing Arcs ............................................................. 56 

Drawing Circles ......................................................... 76 
Drawing Lines .......................................................... 120 

Drawing Multiple Lines ........................................... 120 

E 

Editing raster 

gACTIVE ............................................................... 54 

Erasing raster 

Despeckling 

gSPECKL ......................................................... 174 

gCROP ................................................................... 89 
gEDGE ................................................................. 105 

gERASE ............................................................... 106 

gRUB ................................................................... 157 

F 

File Writers .............................................................. 158 

G 

gACLEAN ................................................................. 53 

gACTIVE ................................................................... 54 

gADESKEW .............................................................. 55 
gARC ......................................................................... 56 

gARRAY ................................................................... 57 

gATTACH ................................................................. 59 

gAUTOSNAP ............................................................ 62 
gBURN ...................................................................... 64 

gCai ............................................................................ 87 

gCALIKE ................................................................... 68 
gCARC....................................................................... 69 

gCCIRCLE ................................................................. 70 

gCCIRCLE2P............................................................. 71 
gCELEV ..................................................................... 72 
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gCHANGE ................................................................. 73 

gCHGLAY ................................................................. 75 
gCIRCLE ................................................................... 76 

gCLEANIOP .............................................................. 77 

gCLINE...................................................................... 78 
GCLINE ..................................................................... 78 

gCONCEN ................................................................. 79 

gCONVRT ................................................................. 80 
gCOPY ....................................................................... 85 

gCREATE .................................................................. 88 

gCROP ....................................................................... 89 
gCTEXT .................................................................... 90 

gCUT ......................................................................... 96 

gDESKEW ................................................................. 99 

gDETACH ............................................................... 101 
gECONVRT ............................................................. 103 

gEDGE ..................................................................... 105 

gERASE ................................................................... 106 
gFRZLAY ................................................................ 107 

gHELP ..................................................................... 108 
gHTEXT .................................................................. 109 

gHYBRIDMODE..................................................... 111 

gINACTIVE ............................................................. 113 
gINFO ...................................................................... 114 

gINVERT ................................................................. 116 

gISOLAY ................................................................. 117 
gJOIN ....................................................................... 118 

gLINE ...................................................................... 120 

gLINE2 .................................................................... 120 

gMAI ....................................................................... 125 

gMCOPY ................................................................ 121 

gMIRROR ................................................................ 122 

gMOVE.................................................................... 123 
gOFFSET ................................................................. 126 

gOSR ...................................................................... 127 

gPASTE .................................................................. 127 

gPDFATTACH ........................................................ 132 

gPDFEXTRACT ...................................................... 134 
gPDFSAVE .............................................................. 136 

gRAHEAD ............................................................... 138 

gRAI ........................................................................ 156 
gRASTER ................................................................ 139 

gRECTANGLE ........................................................ 145 

gREFLCT ........................................................ 146, 148 

gRELIMIT ............................................................... 149 

gRESIZE .................................................................. 150 

gROTATE ................................................................ 151 
gROTRECTANGLE ................................................ 154 

gRUB ....................................................................... 157 

gSAI ......................................................................... 162 
gSAVE ..................................................................... 158 

gSCALE ................................................................... 160 

 
gSETLAY ................................................................ 168 

gSLICE .................................................................... 169 

gSMOOTH ............................................................... 170 
gSPECKL ................................................................. 174 

gTCONFIG .............................................................. 176 

gTEXT ..................................................................... 185 
gTRACE ................................................................. 187 

gTRAIN ................................................................... 200 

gTURN..................................................................... 203 

GTXRAST.CFG ...................................................... 209 
gVECTOR................................................................ 204 

gVSKEW ................................................................. 205 

gWARP .................................................................... 206 

H 

Help 

gHELP ................................................................. 108 

I 

ICR Plus ................................................................... 200 

Image Frame ............................................................ 112 
Image Transparency ................................................. 112 

Intelligent Object Picking. See IOP ............................ 42 
Inverting raster images 

gINVERT ............................................................. 116 

IOP 2-Point Circle ...................................................... 43 
IOP Add ..................................................................... 42 

IOP All ....................................................................... 42 

IOP AllText ................................................................ 42 

IOP Arc ..................................................................... 43 

IOP Circle ................................................................. 43 

IOP Crossing .............................................................. 42 

IOP Fence................................................................... 43 

IOP Inside .................................................................. 43 
IOP Line ..................................................................... 43 

IOP Object ................................................................. 43 

IOP Outside ................................................................ 43 
IOP Pcrossing ............................................................. 42 

IOP Pinside .............................................................. 43 

IOP Previous .............................................................. 44 

IOP Pwindow ............................................................. 42 
IOP Remove ............................................................... 42 

IOP Segment .............................................................. 44 

IOP TextLine.............................................................. 44 

IOP TextWndow ........................................................ 44 

IOP Under .................................................................. 44 

IOP Undo ................................................................... 44 
IOP View ................................................................... 44 

IOP Window .............................................................. 42 

L 

Loading raster 
gPASTE .............................................................. 127 
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M 

Mirroring raster 
gMIRROR ............................................................ 122 

gREFLECT .................................................. 146, 148 

Move All Images ...................................................... 125 
Moving raster 

gMOVE ................................................................ 123 

N 

Negative images 

gINVERT ............................................................. 116 

O 

Offsetting raster 

gOFFSET ............................................................. 126 

OSR ......................................................................... 127 

P 

Pasting raster 

gPASTE .............................................................. 127 

perpendicular.............................................................. 52 

R 

Raster files 

Formats ................................................................ 213 
Information 

gINFO .............................................................. 114 

Raster Files 
Limits ................................................................... 114 

Raster Formats 

Saving .................................................................. 158 
Raster limits 

gRESIZE .............................................................. 150 

Raster snap 
tangent .................................................................... 52 

Raster snaps ............................................................... 52 

center...................................................................... 52 
edge ........................................................................ 52 

end ......................................................................... 52 

intersection ............................................................. 52 
List ......................................................................... 52 

mid-arc ................................................................... 52 

midpoint ................................................................. 52 
near ........................................................................ 52 

none ....................................................................... 52 

perpendicular to arc ................................................ 52 

Running .................................................................. 52 
Recognition Files 

Training ................................................................ 200 

Reflecting raster 
gMIRROR ............................................................ 122 

gREFLECT .................................................. 146, 148 

Resizing images 
gRESIZE .............................................................. 150 

Resolution ................................................................ 114 

Maximum Pixels .................................................... 88 
Rotate All Images ..................................................... 156 

Rotating raster 

gDESKEW ............................................................. 99 

gROTATE ............................................................ 151 

gTURN ................................................................. 203 

Rubber sheeting 
gWARP ................................................................ 206 

S 

Saving raster 
gCUT ..................................................................... 96 

gSAVE ................................................................. 158 

Scale All Images ...................................................... 162 
Scaling raster 

gSCALE ............................................................... 160 

Smoothing raster 
gSMOOTH ........................................................... 170 

Snapping 

See raster snaps ...................................................... 52 

Software Configuration ............................................ 202 

Speckle removal 
gSPECKL ............................................................. 174 

Stretching raster geometry 

gCHANGE ............................................................. 73 

T 

Text Configuration ................................................... 176 

Title blocks................................................................. 89 
Tracing raster with vector 

gTRACE ............................................................. 187 

Tracing Raster with Vector ...................................... 204 

W 

Warping raster 

gWARP ................................................................ 206 

 


